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Introduction
Please read this manual.    It is short and easy to read.
Feel free to submit comments, suggestions, and bug reports.
TimeSlice® developed by: Maui Software

postal address: 7960-B Soquel Dr. #216
Aptos, CA    95003

voice/fax: 1-408-689-9314
email: info@mauisoftware.com

windows specific email: lois@mauisoftware.com
web site: http://www.mauisoftware.com

©Copyright 1995, 1996, 1997 1998 Maui Software.
All Rights Reserved Worldwide.

Credits
TimeSlice graphics (startup window, and about box) by

Ed Fenner
Design Mine
Boulder, CO
303.530.4365 / 800.779.2433
email: DesignMine@AOL.COM

TimeSlice program and user's manual icon graphics by
Halvor Nome
NOME A/S Design & Market Communication
Karl Johansgt. 20
N-1776 Halden.
email: nome@oslonett.no

And thanks to all the people who helped beta test TimeSlice.



New Features in this Version
New features for TimeSlice version 1.1.0

· Expense Feature:
· There is now a column which stores a currency amount with each Time row.

· New Export Features:
· Option to Export (or not) the column titles row.
· Option to Export (or not) the totals row.
· Export option to get rid of "carriage returns" in the Notes text.
· Option to specify which columns to include in the Export File.
· Export option to append to an existing file or create a new file.

· New Print Features:
· Option to specify the text for the Report Title (instead of the default - file name).
· Option to Print (or not) the report title and page number.
· Option to Print (or not) the column titles row.
· Option to Print (or not) the totals row. 
· Option to add a blank line after each row in the Printed Report.
· Option to specify which columns to include in the Printed Report.
· Specify the Font type, style and size to use in the Printed Report. 

· New Column Settings:
· Option to hide columns in the Time Table.
· "Center", "Left" or "Right" justification can be set for the Column Data and Headings in the 

Time Table. 
· Edit Column names. These names will be displayed in the Time Table and will be used in the 

Export file and Print report.
· Total "Active", "Marked", or "All" Records: 

· Menus to select to show the "Total Active Record", "Total Marked Records", or "Total All 
Records" in the "Total Time", "Total Charge", and "Total Expenses" boxes in the document 
window. 

· Time Table Horizontal and Vertical Splitter Bars:
· The Time Table has a vertical and horizontal splitter bar so that one section of the table can 

be shown and the rows or columns on the other section can be scrolled.
· Command and View Time data while TimeSlice application is minimized 

· The TimeSlice icon is replaced with a "red", "green", or "yellow" icon when the document or 
application window is minimized. The icon represents the state of the timer in the document, 
or in the case of the minimized program, it represents the state of the timer of the "active" 
document. 

· Minimized TimeSlice program has a pop-up system menu where each TimeSlice document 
has a sub-menu. The following is shown or are allowed commands for each open TimeSlice 
Document: 1). Show the red, green or yellow icon next to the Document name, 2). Shows the 
Active or Marked or All Time, 3). Start/Stop/Restart Menu, 4). Pause/Restore menu, 5). Edit 
Active Time Record, 6). Set as Active Document. (The application system menu is popped up
by clicking the right mouse button on the minimized TimeSlice icon.)

· Suggestions from our customers:
· Create an UnDelete TimeTable Row Menu.
· Tab to the "hourly rate" column in the Edit Project, Category, Client dialog box. 
· Add Project, Category, Client name by typing in the combo list boxes in the TimeTable or the 

Edit Time Dialog box.
· Make the drop down list box for the Project, Category, Client names wider.
· Option to not display the "Delete Row Confirmation Dialog Box".
· Entering the time 12:xx without any am or pm in the TimeTable will default the value to 12:xx 

PM.
· TimeSlice will remember the Status bar and Tool bar view settings for the next time TimeSlice

program starts.
· Option to Export and Print the Mark Column.



· Ability to "Tab" forward or "Shift-Tab" backward a cell in the Time Table.
· If there are no rows are selected and the timer is active, the active time record will be edited 

in the Edit Time Dialog Box when the Edit Time menu, F6 is pressed, or the Edit Time button 
in the tool bar is pressed. 

· A double click on a specific cell will bring up the Edit Time Dialog Box with the cursor in the 
area to edit the data from that cell.

· Disable the "Pause/Resume" menu in the document system menu when the timer is not 
active.

· The Project, Category, Client lists are sorted (or not sorted) in the Mark Special Dialog Box, 
Edit Time Dialog Box and the TimeTable according to the sort always setting in the Edit 
Project, Category and Client Dialog Box. 

· If the time is edited in the Time Table and the seconds are not specified to be displayed, 
eliminate the seconds stored. As an example, if the start time is edited to be 10:03 and the 
stop time is edited to be 12:03, the elapsed time is set to 2:00 and not rounded up to 2:01 
because there are extra seconds. 

· Problems fixed:
· Make sure that if Auto-Save is enabled, not more than one "save error" dialog box will be 

displayed at a time.
· If a file was closed with the window compacted, the compacted window will be positioned in 

the same position when opened again.
· Fixed the problem where a compacted window was saved, closed, then reopened, but 

restoring the window did not put the window in the same position when initially compacted.
· Fixed the problem where the TimeTable scroll bars were not always visible when the 

document window also had scroll bars.
· Fixed the problem where the Elapsed Time Column Width was not save correctly with the 

document.
· Fixed the problem where the TimeTable was not sized correctly when the document window 

was maximized and the program window minimized when the application is closed.

New features for TimeSlice version 1.0.1
· Add information about our new California office.

New features for TimeSlice version 1.0.0
· New Project, Category and Client Columns.    Enter multiple text and hourly rate pairs for each 

column.    Select from your defined list for each column for each time record.
· Cut, Copy, Paste and Delete text when text editing within the cell of the Time Table.
· Auto Adjust Dates and Times when editing times in the Time Table or Edit Time Dialog Box.    Set 

Auto Adjust Preferences.
· Hourly Rate setable per record.
· Restart a Time Table Row.
· Time Status Light shows “Green” when the timer is started, “Yellow” when the timer is paused, 

and “Red” when the timer is not running.
· TimeSlice Document Window and Program Window size and locations and the column widths are

saved and used next time the TimeSlice Program or one of its Documents are opened.
· TimeSlice Startup Preferences where you can select to have TimeSlice open a New Document, 

open no Documents, or open the Documents that were open last time you exited TimeSlice.
· Start, Restart, Pause, Resume and Stop menus in the menu bar and each has associated 

function keys.
· Ease of inputting Time values.    If you have the time display setting to use the ‘:’, you can use the 

‘.’ to more easily enter in time values and TimeSlice will change it appropriately to a ‘:’.
· Mark Column that helps select rows with specific characteristics.    For instance, mark the rows 

with a specific date and Project column text value.    Then Print or Export just these marked rows.  
The marked rows can also be selected more easily for copy or deletion.

· Export or Print Preferences allows to print or export all records in a file, or a marked subset of the 
records.

· Sort Row Option.    From 0, 1, 2 or 3 columns can be specified to sort on.



New features for TimeSlice Lite version 2.0.0
· International Format Date, Time and Currency values available in the 32 bit version of TimeSlice. 

(uses Regional Settings)
· Print entire Notes field on a subsequent line(s) with a Print option.
· Edit Time Information in the Time Table Cell as well as in the Edit Time Dialog Box.
· Easy method to Add Time Information manually.
· Select All / Select None - rows in the Time Table by clicking on the upper left corner of the Time 

Table.
· Time Table sizes larger when the Document window sizes larger.
· Tool Tips appear when the cursor passes over the Toolbar buttons in the 32 bit version of 

TimeSlice.
· Scroll bars appear in the TimeSlice application and document windows when needed.
· The Stop Date and Pause Time columns are added to the Time Table and the Printed report.
· The Active Time Record has an bold font in the Time Table.
· Sizable Columns in the Time Table.
· The Edit Time Entry Button pops up the Edit Time Dialog Box with the last row or Active Time 

Record when the Document window is compacted.

New features for TimeSlice Lite version 1.2.0
· 16 and 32 bit versions of the program (Windows 3.1, 95 and NT versions).
· Printed Report has a total line at the end.
· February can have 29 days.
· Select All, Select None Menu - select all or no rows in the Time Table.
· Tile Vertical and Horizontal Menu - tile TimeSlice Document Windows 
· Toolbar on the Child Window
· New Compact Window feature (screen space saver) to compact each child window separately.
· Initial Focus in the Notes edit area in the Edit Time Entry Dialog box.

New features for TimeSlice Lite version 1.1.0
· Cut, Copy, Paste, Clear    - time entries (rows) in the table.
· Copy, Cut - will also copy the highlighted time entries tab delimited to the clipboard.
· Can edit the active time entry
· Icon on the icon bar to toggle the Compress/Restore Child Window Menu
· Preference setting for Time Display.    For instance, display in one second, one minute 6 minute, 

15 minute increments.    Can also select time displayed in decimal notation, i.e.: two hours and 18
minutes displayed in decimal notation in 6 minute increments is displayed as 02.30

Features for TimeSlice Lite version 1.0.0
· Start/Stop and Pause/Resume button
· Multi-Document Interface
· Print / Print Preview Time Events report
· Export time events to tab delimited file
· Extensive online help - MS Help format
· Automatic Charge calculation
· Automatic Document total charge and total time calculation
· Default Hourly Rate Preference setting
· Hourly Rate set per document
· Application Window compacting option for minimal screen usage



Software License Agreement
MAUI SOFTWARE END-USER LICENSE AGREEMENT
NOTICE. Please read this Agreement before using the accompanying software and any documentation (the 
"Software"). By using the Software, you agree to be bound by the terms of this legal Agreement between you, the 
end user ("User"), and Lois Genzmer doing business as Maui Software, hereafter referred to as “Maui Software.” If
you do not agree to these terms, Maui Software is unwilling to license the Software to you and you should 
promptly return the Software together with all accompanying items, disc (if applicable),package (if applicable) and
proof of payment to the reseller from whom you purchased it, for a full refund. If you have any questions regarding
this Agreement, please contact Maui Software by email at <sales@mauisoftware.com> or by regular mail at Maui 
Software, 7960-B Soquel Dr, #216, Aptos, CA 95003, USA.
LICENSE GRANT. The copy of the Software accompanying this Agreement is owned by Maui Software and 
protected by United States copyright laws and international treaties. All rights not expressly granted are reserved 
by Maui Software. Upon receipt of full payment for the Software, Maui Software grants User the right to use one 
copy of the Software on a single computer at one time, for User’s own personal use only. If User would like to use 
the Software on more than one computer at the same time, User must purchase a separate license for each 
additional computer on which the Software is to operate. 
RESTRICTIONS. User may not make any copies of the Software, except a reasonable number of backup copies 
used solely for backup purposes. User may not decompile, reverse engineer, disassemble, decode or otherwise 
reduce the Software to a human perceivable form. User may not modify, network, rent, lend, loan, distribute or 
create derivative works based upon the Software, in whole or in part. User may not electronically transmit the 
Software from one computer to another or over a network. User may not remove from the Software or 
accompanying materials any copyright or trademark notices, logos, product or company names, labels or 
identifications. User may not distribute, give away, or publish the program serial number(s).
WARRANTY DISCLAIMER. MAUI SOFTWARE DOES NOT WARRANT THAT THIS SOFTWARE WILL 
MEET YOUR REQUIREMENTS OR THAT ITS OPERATION WILL BE UNINTERRUPTED OR ERROR-
FREE. MAUI SOFTWARE EXCLUDES AND EXPRESSLY DISCLAIMS ALL EXPRESS AND IMPLIED 
WARRANTIES, INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 
A PARTICULAR PURPOSE. THESE WARRANTY LIMITATIONS MAY NOT APPLY TO USERS IN SOME 
STATES.
DEFECTIVE DISC. For Users who received from Maui Software the Software recorded on a disc, User’s sole and 
exclusive remedy for a defective disc shall be either replacement of the defective medium or refund of the license 
fee, at the reseller’s (from whom purchased) option, upon return of the Software to the reseller within thirty (30) 
days of purchase, together with all accompanying items, disc, documentation, package (if applicable) and proof of 
payment.
LIMITATION OF LIABILITY. MAUI SOFTWARE SHALL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, 
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES (INCLUDING LOST PROFITS) ARISING OUT
OF THE USE OF, OR INABILITY TO USE, THE SOFTWARE, EVEN IF MAUI SOFTWARE HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. THESE LIABILITY LIMITATIONS MAY NOT 
APPLY TO USERS IN SOME STATES.
TERMINATION. This license and User's right to use the Software automatically terminates if User: (i) fails to 
comply with any of the provisions of this Agreement, (ii) destroys the copy and any backup copy of the Software 
in User's possession, or (iii) voluntarily returns the Software to Maui Software. Upon termination, User shall cease 
all use of the Software and destroy, or return to Maui Software, all copies of the Software then in User's 
possession, and take such other actions as Maui Software may reasonably require to ensure that no copies of the 
Software remain in User's possession. 
GENERAL PROVISIONS. This is the entire agreement between the parties relating to the Software, and this 
Agreement supersedes any purchase order, communication, advertising or representation concerning these matters. 
This Agreement will be governed by and construed in accordance with the laws of the State of California, and any 
dispute arising from this Agreement shall be settled in, and the parties consent to jurisdiction in, the State of 
California. Should any provision of this Agreement be held to be void, invalid or unenforceable by a court, the 
validity and enforceability of the other provisions shall not be affected thereby. Failure of a party to enforce any 
provision of this Agreement shall not constitute or be construed as a waiver of such provision or of the right to 



enforce such provision.
REGISTRATION AND TECHNICAL SUPPORT. User shall be entitled to reasonable technical support from Maui
Software only if User registers by following the registration instructions in the Software. 



How To Order TimeSlice
Refer to the readme.txt file for ordering instructions.



How To Register TimeSlice
Once you have received your name and registration code, you can register your copy of 
TimeSlice.    Enter in your Registration Name and Registration Code to change TimeSlice 
from a demo version to a full working version registered to you.
To register TimeSlice with your registration code:

1. Start TimeSlice.
2. The Demo Version Introduction dialog box will be displayed.    Click on the "Register 

Now" button.    The Register TimeSlice dialog box will be displayed.
3. Enter your Registration Name and Registration Code exactly as given to you by Maui 

Software.
4. Click on the "Register" button.    If you receive an error, verify that the name and code

you entered is exactly as Maui Software gave to you.
NOTE: Your name and registration code is entered in the Registry Database automatically if 
you are using the 32bit version of TimeSlice for Windows.    Your name and registration code
is entered in the "TimeS.ini" file automatically if you are using the 16bit version of 
TimeSlice for Windows.    The "TimeS.ini" file resides in the Windows directory.    If the 
registration information in this file is changed or corrupted, the TimeSlice program reverts 
back to demo mode.    Keep your Name and Registration code that Maui Software gave to 
you in a safe place in case you need to enter the registration information again.



File Menu

The File Menu contains commands to create a new document, open an existing document 
and save an open document to a disk file.    The commands to export the document 
information into a tab delimited file, print a report of the information in the document, and 
exit the TimeSlice program are also available under the File Menu.
New Ctrl+N

Use this command to create a new document in TimeSlice.    A new document window will
be opened.    The 'Ctrl N' key sequence can be used to create a new document also.    See
Start a New Document for more information.

Open... Ctrl+O
Use this command to open an existing document in a new window.    The 'Ctrl O' key 
sequence can be used to open an existing document also.    See Open an Existing 
Document for more information.

Close
Use this command to close the window containing the active document.    TimeSlice 
prompts you to save the document if it has unsaved changes.    Before closing an 
unnamed document, TimeSlice displays the Save As dialog box and suggests that you 
name and save the document.

Save Ctrl+S
Use this command to save the active document with its current name and location.    
When you save a document for the first time, TimeSlice displays the Save As dialog box 
so you can name your document.    If you want to change the name or location of an 
existing document, choose the Save As command.    The 'Ctrl S' key sequence can be 
used to save the active document also.    See Save a Document for more information.

Save As...
Use this command to save and name the active document.

Export... Ctrl+E
Use this command to save the time entries of the active document to a tab delimited file.



The 'Ctrl E' key sequence can be used to Export the active document also.    See Export a 
Document for more information.

Print... Ctrl+P
Use this command to print document reports.    The 'Ctrl P' key sequence can be used to 
Print the active document also.    See Print a Report for more information.    The Print 
preference can be set in the Document Preferences dialog box.

Print Preview
Use this command to switch the active document to and from print preview, with which 
you can see how the document report will look when you print it.    See Print a Report for 
more information.

Print Setup...
Use this command to select a printer and a printer connection.    The printer selected will 
be the printer designated as the selected printer when printing a report.

1, 2, 3, 4
Use the numbers and filenames listed at the bottom of the File menu to open the last 
four documents you closed.    Choose the number that corresponds with the document 
you want to open.

Exit
Use this command to end the TimeSlice program.    TimeSlice prompts you to save 
documents with unsaved changes.



Edit Menu

The Edit Menu contains the commands to Undo, Cut, Copy, Paste, Delete, Select All, Select 
None, Projects, Categories and Clients.    The Undo command will roll back the last editing 
done while editing in a cell in the Time Table.    The Cut and Copy commands will copy the 
highlighted rows from the Time Table to an internal buffer.    The buffer internal to TimeSlice 
will exist until the TimeSlice program is exited.    The Cut and Copy commands will also copy
the highlighted rows to the Clipboard as tab delimited text.    This text is the same format of
tab delimited text that is saved to a file using the Export feature.    The Select All and Select
None command will highlight or UN-highlight all rows in the Time Table.    The Projects, 
Categories and Clients menus display the dialog that allows for editing of the text and 
hourly rates for the Project, Category, and Client columns.
Undo Ctrl+Z

The Undo command will undo the last text editing done while you are still editing in a cell
of the Time Table.    This menu is only valid during an active edit of the contents of a Time
Table cell.

Cut Ctrl+X
The Cut command will delete the highlighted rows from the Time Table.    A copy of the 
highlighted rows information will be saved in an internal TimeSlice buffer.    This internal 
buffer will allow the user to paste the information into a TimeSlice document at a later 
time.    The highlighted rows information will also be saved as "tab" delimited text in the 
Clipboard.    This text is the same format of tab delimited text that is saved to a file using 
the Export feature.    The 'Ctrl X' key sequence can be used to initiate the Cut command.   
The Cut command can also be activated by selecting the Cut Button from the TimeSlice 
application Toolbar.

Copy Ctrl+C
The Copy command will save a copy of the highlighted rows in the Time Table.    The 
highlighted rows will be copied as "tab" delimited text to the Clipboard.    This text is the 
same format of tab delimited text that is saved to a file using the Export feature.    An 
internal TimeSlice buffer will also hold a copy of the information in the highlighted rows.   
This information held in the internal buffer will then available to be "Pasted" in the Time 
Table.    This internal TimeSlice buffer is cleared when the TimeSlice program "Exits".    
The 'Ctrl C' key sequence can be used to initiate the Copy command.    The Copy 
command can also be activated by selecting the Copy Button from the TimeSlice 
application Toolbar.

Paste Ctrl+V
The Paste command will copy the internal TimeSlice buffer into the Time Table.    If one 



row is selected, the rows will be added before the selected row.    Otherwise, the new 
rows will be added to the end of the Table.    Only highlighted rows that have been 
previously Cut or Copied from within TimeSlice can be Pasted.    The 'Ctrl V' key sequence
can be used to initiate the Paste command.    The Paste command can also be activated 
by selecting the Paste Button from the TimeSlice application Toolbar.

Delete Del
The Delete command will delete the highlighted rows from the Time Table.    The rows 
deleted will NOT be put in the Clipboard or saved to the internal TimeSlice buffer.    
Pressing the 'Delete' key can be used to initiate the Delete command.    The Delete 
command can also be activated by selecting the Delete Button from the TimeSlice 
Document Window Toolbar.

Select All Ctrl+A
The Select All command will highlight all rows in the Time Table.    The 'Ctrl A' key 
sequence can be used to initiate the Select All command.    The Select All and Select 
None commands can be toggled by clicking on the upper left corner of the Time Table.

Select None
The Select None command will UN-highlight all rows in the Time Table.    The Select All 
and Select None commands can be toggled by clicking on the upper left corner of the 
Time Table.

Project Ctrl+J
The Projects command will display the Edit Project, Category, Client Dialog box.    Select 
this menu to edit the list of Project names to select from in the Project Column.    Select 
this menu to edit hourly rates associated with the Project Name.    See the Project, 
Category and Client Columns for more information on how to utilize these columns.

Categories Ctrl+R
The Categories command will display the Edit Project, Category, Client Dialog box.    
Select this menu to edit the list of Category names to select from in the Category 
Column.    Select this menu to edit hourly rates associated with the Category Name.    See
the Project, Category and Client Columns for more information on how to utilize these 
columns.

Clients Ctrl+I
The Clients command will display the Edit Project, Category, Client Dialog box.    Select 
this menu to edit the list of Client names to select from in the Client Column.    Select this
menu to edit hourly rates associated with the Client Name.    See the Project, Category 
and Client Columns for more information on how to utilize these columns.



Time Menu

The Time Menu contains commands to edit a time table row, add a time table row, edit a 
time table cell, delete a time table row, undelete a time table row, to set Document 
Preferences for the active document, to set General TimeSlice program preferences, toggle 
the mark cell of the selected Time Table rows, set the mark cell of all Time Table rows, 
unset the mark cell of all Time Table rows, select the Time Table rows that have the mark 
cell set, display the Mark Special Dialog Box, sort the Time Table rows by specified criteria, 
start the timer, stop the timer, pause the timer, resume the timer, and restart the timer.    
Time Menu Commands also include three toggles to select the type of totals to display in 
the total time, total charge and total expenses where the options include total active, total 
marked and total all time records.

Edit Time Table Row... F6
Use this command to display the Edit Time dialog box.    The Time Table row(s) that is 
highlighted in the active document will be available for editing in this dialog box.    The 
Edit Time Table row command can also be activated by selecting the Edit Time Button 
from the TimeSlice Document Window Toolbar.    Pressing the 'F6' key can be used to 
initiate the Edit Time Table Row command.

Add Time Table Row Ins
Use this command to manually add Time Records to the Time Table.    Pressing the 'Insert'
key will also initiate the Addition of a record to the Time Table.    See Manually Add Time 
Entry for more information on manually adding time information in the Time Table.

Edit Time Table Cell F2



Use this command to initiate the Edit of the selected Time Table Cell.    Pressing the 'F2' 
key will also initiate the Edit of the selected Time Table Cell.    The time table cell that has
the dashed "input" highlight in the Time Table in the active document will be put into edit
mode.    The Edit Time Table Cell command can also be activated by selecting the Edit 
Time Table Cell Button from the TimeSlice Document Window Toolbar.    See Edit Time 
Entry for more information on editing time information in the Table Cell.

Delete Time Table Row Del
Use this command to delete rows from the Time Table.    Pressing the 'Delete' key will also
initiate the deletion of selected rows from the Time Table.    The rows deleted will be 
saved to the internal “Undelete” TimeSlice buffer.    The Delete command can also be 
activated by selecting the Delete Button from the TimeSlice Document Window Toolbar.

Undelete Time Table Row
Use this command to undelete rows that have previously been deleted from the Time 
Table with the “Delete Time Table Row” command.    The rows deleted previously will be 
pasted back into the Time Table.    This command is grayed out when there are no rows in
the internal “undelete” buffer to restore.

Document Preferences... F7
Use this command to display the Document Preferences dialog box.    The preferences 
specific to the active document can be set here.    The document specific preferences 
include the time display options and print options.    The Document Preferences 
command can also be activated by selecting the Document Preferences Button from the 
TimeSlice Document Window Toolbar.    Pressing the 'F7' key will also display the 
Document Preferences dialog box.

General Preferences... F8
Use this command to display the General Preferences dialog box.    The auto-save, 
startup, and auto-adjust time settings can be set in the General Preferences Dialog Box.   
The window compacting options can also be set here.    The TimeSlice General 
Preferences command can also be activated by selecting the General Preferences Button 
from the TimeSlice Document Window Toolbar.    Pressing the 'F8' key will also display the
General Preferences dialog box.

Mark / Unmark Ctrl+M
Use this command to toggle the state of the Mark cell of the selected Time Table rows.    
The 'Ctrl M’ key sequence can be used to initiate the Mark / Unmark command.

Mark All
Use this command to check the Mark cell of all Time Table rows.

Unmark All
Use this command to uncheck the Mark cell of all Time Table rows

Select Marked
Use this command to select the Time Table rows that have the Mark cell checked.

Mark Special... F9
Use this command to display the Mark Special Dialog Box. The TimeSlice Mark Special 
command can also be activated by selecting the Mark Special Button from the TimeSlice 
Document Window Toolbar.    Pressing the 'F9' key will also display the Mark Special 
dialog box.

Sort... Ctrl+B



Use this command to sort the Time Table rows by specified criteria.    Use this command 
to display the Sort Dialog Box.    The ‘Ctrl B’ key sequence can be used to display the Sort
Dialog Box.

Start F4
Use this command to start the timer.    A new row will be added to the Time Table with the
start time filled by the current time.    The timer can also be started by selecting the Start
Button from the TimeSlice Document Window Toolbar.    Pressing the ‘F4’ key will also 
start the timer.    This menu will be greyed out when the timer is already active.    This 
menu will also be greyed out when only one row is selected.    One row selected is the 
way you specify a row to restart the timer on.    The ‘Start’ button will show the time of 
‘3:00’ to show that start is valid rather than restart.    See restart below for more 
information.    The status light will turn green when the timer is started.    See Time an 
Activity for more information on starting the timer.

Stop F4
Use this command to stop the timer.    The row in the Time Table with the active timer will
stopped.    The row with the active timer has a ‘bold’ font.    The timer can also be stopped
by selecting the Stop Button from the TimeSlice Document Window Toolbar.    Pressing 
the ‘F4’ key will also stop the timer.    This menu will be greyed out when the timer is not 
running.    The status light will turn red when the timer is stopped.    See Time an Activity 
for more information on stopping the timer.

Pause F5
Use this command to pause the timer.    The row in the Time Table with the active timer 
will be paused.    The row with the active timer has a ‘bold’ font.    The timer can also be 
paused by selecting the Pause Button from the TimeSlice Document Window Toolbar.    
Pressing the ‘F5’ key will also pause the timer.    This menu will be greyed out when the 
Timer is already paused or when the timer is not started.    The status light will turn 
yellow when the timer is paused.    See Time an Activity for more information on pausing 
the timer.

Resume F5
Use this command to resume the timer. The row in the Time Table with the paused timer 
will resume timing the elapsed time.    The row with the paused timer has a ‘bold’ font.    
The timer can also be resumed by selecting the Resume Button from the TimeSlice 
Document Window Toolbar.    Pressing the ‘F5’ key will also resume the timer.    This menu
will be greyed out when the Timer is not paused.    The status light will turn green when 
the timer resumes.    See Time an Activity for more information on resuming the timer.

Restart F4
Use this command to restart the timer on the selected row.    This command is only valid 
when only one row is selected and the timer is not currently active. The timer can also be
restarted by selecting the Restart Button from the TimeSlice Document Window Toolbar.   
Pressing the ‘F4’ key will also restart the timer.    This menu will be greyed out when the 
timer is already active.    This menu will also be greyed out when no rows are selected or 
more than one row is selected.    One row selected is the way you specify a row to restart 
the timer on.    The ‘Restart’ button will show the time of ‘3:10’ to show that restart is 
valid rather than start.    See restart below for more information.    The status light will 
turn green when the timer is restarted.    See Time an Activity for more information on 
restarting the timer.

Total Active Time Record Ctrl + 1
Use this command to select that the active rows ‘Elapsed Time’, ‘Charge’, and ‘Expense’ 
is displayed in the boxes above the Time Table.    The Active Elapsed Time will also be 



displayed in the pop-up menu for this document in the TimeSlice Application system 
menu.    The Total Active Time Record is selected when the check mark is displayed in the
front of this menu.    The total setting is saved with each document.

Total Marked Time Records Ctrl + 2
Use this command to select that the total of all marked rows ‘Elapsed Time’, ‘Charge’, 
and ‘Expense’ is displayed in the boxes above the Time Table.    The Total Marked Elapsed
Time will also be displayed in the pop-up menu for this document in the TimeSlice 
Application system menu.    The Total Marked Time Records is selected when the check 
mark is displayed in front of this menu.    The total setting is saved with each document.

Total All Time Records Ctrl + 3
Use this command to select that the total of all rows in this document’s ‘Elapsed Time’, 
‘Charge’, and ‘Expense’ is displayed in the boxes above the Time Table.    The Total All 
Elapsed Time will be displayed in the pop-up menu for this document in the TimeSlice 
Application system menu.    The Total All Time Records is selected when the check mark is
displayed in front of this menu.    The total setting is saved with each document.



View Menu

You can display or hide parts of the screen to achieve the balance you want between 
graphical features and the size of the area this application uses on the screen.
Toolbar

Use this command to display and hide the Toolbar, which includes buttons for some of 
the most common commands in TimeSlice, including New, Open, Save, Cut, Copy, Paste, 
Print, Compact/Restore and Help.    A check mark appears next to the command name 
when the Toolbar is displayed.

Status Bar
Use this command to display and hide the Status Bar.    The Status Bar will display a 
description of selected menus and buttons.    A check mark appears next to the command
name when the Status Bar is displayed.



Window Menu

The Window Menu contains commands to manipulate the child window within the TimeSlice
program window.    The Cascade, Tile - Horizontal, Tile - Vertical, Arrange Icons, 1,2,3,4, are 
standard Multi-Document Interface commands.    The Compact Windows and Restore 
Windows commands are specific to the TimeSlice program.
Cascade

This command arranges TimeSlice document windows so that they overlap.    The title 
bar of each window remains visible, making it easy for you to select any window.

Tile - Horizontal
This command arranges TimeSlice document windows one above the other, so that each 
window is visible and none overlap.

Tile - Vertical
This command arranges TimeSlice document windows side by side, so that each window 
is visible and none overlap.

Arrange Icons
This command will arrange TimeSlice document windows that are reduced to icons, so 
that you can see them all.

Compact Windows
This command will compact the TimeSlice document window(s).    See Compact Screen 
Usage for more information.

Restore Windows
This command will restore the TimeSlice application window to the size and location 
when the Compact Windows command was executed.    See Compact Screen Usage for 
more information.

1, 2, 3, 4 
This command will make an opened TimeSlice document window active when you choose
its name from this list.    All open TimeSlice document windows are listed, including those 
that have been reduced to icons.



Help Menu

Help Contents
Use this command to display the opening screen of TimeSlice in the Windows Help 
application.    From the opening screen, you can jump to specific instructions for using 
TimeSlice and to various types of reference information.    The Help command can be 
activated by selecting the Help Button from the TimeSlice Document Window Toolbar.    
The Help command can also be activated by selecting the Help Button from the 
TimeSlice application Toolbar.

About TimeSlice
Use this command to display the version number of this copy of TimeSlice for Windows.    
The copyright notice and the TimeSlice registration information to is also displayed.



TimeSlice Application System Menu

The TimeSlice application system menu can be activated by clicking the right mouse 
button on the application minimized icon.    The TimeSlice application system menu can 
also be activated by clicking the left mouse button on the TimeSlice program icon which 
is in the upper left corner of the TimeSlice application menu.    The standard system 
menus appear at the top:    Restore, Move, Size, Minimize, Maximize and Close.    
TimeSlice Document File Name Menu:    The file name of all open TimeSlice 
documents appear at the bottom of the application system menu.    To the left of every 
TimeSlice File Name will be a red, yellow or green icon.

 The icon will be red if the timer for that document is stopped.
 The icon will be green if the timer for that document is running.
 The icon will be yellow if the timer for that document is paused.

The pop-up arrow appears to the right of every TimeSlice File Name.    The arrow signifies 
that the TimeSlice document pop-up menu will appear when the TimeSlice File Name menu 
is highlighted.
TimeSlice Document Pop-up Menu

The TimeSlice Document pop-up menu has three sections.    The sections are the 
document timer information, the timer control menus, and two command menus.
Timer Information:    The top section of the pop-up menu contains a time description 
and time information.    The time section is informational only, these are not command 
menus.

Elapsed Time Description:    The time description denotes if the elapsed time value
is of the ‘Total Active Time Record’, ‘Total Marked Time Records’, or ‘Total All Time 
Records’.    You can select which value to display by selecting the menu under the 
Time Menu.    See Setting Time Records to Total for more information about selecting 
the Total Elapsed Time value to display.
Elapsed Time Value:    The time value is the number of hours : minutes and 
optionally seconds of either the elapsed time of the active record, the total elapsed 
time of all records, or the total elapsed time of all marked records.    The time 
displayed here is the same time that is in the upper left corner of the document 



window above the time table.
Timer Control Menus:    The middle section of the pop-up menu contains two timer 
control menus.

Start/Stop/Restart:    The first row will command the document timer to start, stop, 
or restart the timer.    Select this menu to start, stop or restart the timer for this 
document.
Pause/Resume:      The second row will command the document timer to pause or 
resume the timer.    Select this menu to pause or resume the timer for this document. 
The pause command will be grayed out if the timer is not running for this document.

Command Menus:    The bottom section of the pop-up menu contains two command 
menus.

Edit Active Time Record:    Use this command to edit the active time record for this
document.    This command will display the active time record in the Edit Time Record 
Dialog box.    This command will be grayed out if the timer is not running for this 
document.
Set as Active Document:    This command will make this document the active 
document in the TimeSlice Application.    The total elapsed time (active, all or marked)
of the active document is displayed in the minimized icon of the TimeSlice 
application.    Also in the 32bit version of TimeSlice, the minimized TimeSlice will 
display the red, green or yellow icon to denote the state of the timer of the active 
document.



Set Hourly Rate
The hourly rate is set for each row.    An hourly rate is assigned to each Project, Category 
and Client name entered.    Designate one of these three columns to use the hourly rate for 
calculation of the charge.    A row can also override using the hourly rate from one of the 
three columns (Project, Category, Client) and specify a different hourly rate just for that 
row.
Use the Hourly Rate from the Project, Category, or Client column.
The default column to use the hourly rate from is the Project Column.    The Project, 
Category or Client column can be designated as the column to use the hourly rate from, by 
using the Edit Project, Category, Client Dialog Box.    If the Project Column is designated, 
then the hourly rate associated with the name selected in the Project Column is used to 
calculate the charge for each row.    The hourly rate associated with the selected    name in 
the designated Column is also displayed in the Hourly Rate column.
Override Hourly Rate for a Specific Row
You can decide that you do not want to use an hourly rate from the Project, Category, or 
Client columns.    You override the hourly rate of a row by editing the hourly rate cell in the 
Time Table or editing the hourly rate in the Edit Time Table Row Dialog Box.      The hourly 
rate is then used instead of an hourly rate associated with the Project, Category or Client 
Columns.    Later, use the Edit Time Table Row dialog box if you want to set back to using 
the hourly rate from the Project, Category or Client Columns.
Change Hourly Rate associated with a Project, Category, or Client Name
You change the hourly rate associated with a name in the Project, Category or Client 
column by using the Edit Project, Category, Client Dialog Box .    Changing an hourly rate 
that is associated with a Project, Category or Client name will also be reflected in every 
Time Table row that has that name selected.    The Charge for a Time Table row is 
recalculated when the hourly rate used by that row is changed.

See the Edit Project, Category, Client Dialog Box for more information using the dialog box.   
See Project, Category and Client Columns for more information about using these columns.



Auto Save Feature
The Auto-Save feature of TimeSlice will save the contents of a document every set number 
of minutes.    The Auto-Save feature is set in the General Preferences dialog box.    The 
General Preferences dialog box is displayed by selecting the General Preferences menu 
from under the Time menu.    The General Preferences dialog box can also be displayed by 
selecting the General Preferences Button from the TimeSlice Document Window Toolbar.

The auto-save feature is enabled when the Auto-Save check box is checked.    In the Minutes 
box, type how often (in minutes) you want TimeSlice to save your work.    
NOTE:    The Auto-Save feature will not save a NEW document until a name has been given 
to the document.



Start a New Document
You can start a new document by selecting the New Menu from under the File Menu.    The 
'Ctrl N' key sequence can be used to create a new document.    You can also select the New 
button from the Toolbar to start a New document.    An empty document window inside the 
TimeSlice program window will be opened when a new document is started.



Open an Existing Document
There are many ways to open a TimeSlice document or an earlier version document file.    
Some of the following descriptions are specific on whether you are running the Windows 
3.1 type of "Program Manager" user interface or the Windows 95 "Start Button" user 
interface.    So, look for the descriptions specific to the type of Windows Interface you are 
using.
Use the File-Open Menu or Open Toolbar Button
You can open an existing document by selecting the Open Menu from under the File Menu.   
The 'Ctrl O' key sequence can be used to open an existing document.    You can also select 
the Open button from the Toolbar to open an existing document.    The standard File-Open 
dialog box will be displayed to help you specify which file you want to open.    A document 
window with the requested file is displayed inside the TimeSlice program window when the 
file is opened.
Drop a TimeSlice Document Icon onto a TimeSlice Program

(Windows 95 and Windows NT 4.0)
TimeSlice will start and open a TimeSlice document when a TimeSlice document is dropped 
on the TimeSlice program icon.    One way to organize your files, is to create shortcuts to 
the TimeSlice program and documents on your desktop.    Then drag the first document and
drop it on the TimeSlice program shortcut to start TimeSlice.    Then drop any other 
TimeSlice documents on the running TimeSlice program to open each subsequent 
document.    See the Windows online help for more information on creating shortcuts.
Drop a TimeSlice Document Icon onto a TimeSlice Program

(Windows 3.1 and Windows NT 3.5)
TimeSlice will start and open a TimeSlice document when a document file is dropped on the
TimeSlice icon in the Program Manager.    Open the Program Manager group that has your 
TimeSlice Program icon in it.    Open the File Manager so you can see your TimeSlice 
documents.    Arrange the Program Manager and File Manager so you can drag the 
document from the File Manager and drop it on the TimeSlice icon in the Program Manager.
Double Clicking on a TimeSlice Document Icon

(Windows 95 and Windows NT 4.0)
Double clicking on a TimeSlice document icon will start up the TimeSlice program with that 
document opened.    The TimeSlice document icon or shortcut to the TimeSlice document 
can be activated.    The TimeSlice document icon can be in the Explorer, on the Desktop or 
in the Start Menu.
Double Clicking on a TimeSlice Document Icon

(Windows 3.1 and Windows NT 3.5)
In the File Manager, find the TimeSlice File to be opened in TimeSlice.    Double click on the 
TimeSlice document file.    The TimeSlice Program will be started with the selected 
TimeSlice document opened.    You may need to create an association between the 
TimeSlice Program and the files with a '.ts' extension.    See the Windows online help for 
more information on creating associations between a Program and a file extension.
Using the Properties Page of a Shortcut to TimeSlice Program Icon

(Windows 95 and Windows NT 4.0)
A Shortcut to the TimeSlice Program can be set up to automatically open a specific 
TimeSlice document when the Shortcut Icon is activated.
First, a TimeSlice shortcut icon must be created.    To create a shortcut, select the TimeSlice 
Program file in Explorer.    Drag the TimeSlice Program file to the Desktop or the Start Menu 



directory in your Windows directory to create the shortcut.
Second, edit the Property Page of the shortcut to TimeSlice icon.    To pop-up the Property 
Page, select the shortcut icon and click on the right mouse button and select the Property 
menu.    In the Property page, click on the 'Shortcut' tab.    In the 'Target:' edit area, the 
name of the TimeSlice program path is specified.    In the 'Target:' edit area, add a space 
after the TimeSlice program path and then type in the name of the TimeSlice document file 
including the pathname.    Then click on the OK button.
Using the Program Manager TimeSlice Program Icon

(Windows 3.1 and Windows NT 3.5)
A TimeSlice Program icon can be set up in the Program Manager to automatically open a 
specific TimeSlice document when this TimeSlice Program icon is activated.    In the 
Program Manager TimeSlice icon, edit the properties.    Add the name of the TimeSlice 
document name after the TimeSlice program filename.    See the Windows online help for 
more information on Program manager icons.



Save a Document
You can save an open document by selecting the Save or Save As Menu from under the File 
Menu.    The 'Ctrl S' key sequence can be used to save the active document.    You can also 
select the Save button from the Toolbar to save an open document.    The standard Save As 
dialog box is displayed when the Save As Menu is selected or the document being saved 
has not been assigned a file name.    Use the Save As dialog box to help you specify the 
name of the file to save the documents data into.



Print a Report
You can print a report containing all or a subset of the Time Table rows of a document.    You
print a report by selecting the Print Menu from under the File Menu.    The 'Ctrl P' key 
sequence can be used to Print the active document.    You can select the Print button from 
the TimeSlice application Toolbar to print the active document or select the Print Button 
from the TimeSlice Document Window Toolbar. The active document's information will be 
printed in the report.
Print Preferences
The Print Preferences Dialog box is displayed when you select the Print command.    Select 
the print preferences in this dialog box.    Then select the OK button to display the standard 
Print dialog box.    The standard Print dialog box is displayed to aid in specifying printer 
information.    See Print Preferences dialog box for more information about this dialog box.
Print Preview
You can preview the printed report by selecting the Print Preview Menu from under the File 
Menu.    The Print Preference Dialog box will displayed.    Select the options in this dialog 
box.    Then select the OK button to continue with the Print Preview.
Sorting the Time Table rows for Printing
The Time Table rows are printed in the order that they appear in the Time Table.    If you 
want the Time information to appear in a specific order in a report, first sort the records 
before selecting the Print command.    See Sort Dialog box for more information about 
sorting time table rows.
Print a Custom Report
A custom report utilizing the TimeSlice time data can be created using a Spreadsheet or 
Database program.    Export the TimeSlice data or copy the contents of the TimeSlice 
document to the clipboard.    Import the TimeSlice data or Paste the TimeSlice data from the
clipboard into the Spreadsheet or Database program.    Then define a report in the 
Spreadsheet or Database program and print the Custom TimeSlice report from the 
Spreadsheet of Database program.    See Export a Document for more information on 
exporting.



Export Time Rows
The Export command is located under the File Menu.    The 'Ctrl E' key sequence can be 
used to Export data from the active document.    The Export button is located in the 
Document Window Toolbar.    Use this Export menu or button to save all or some time table 
rows of the active document to a tab delimited file.    This tab delimited file can then be 
imported into almost every database, spreadsheet, and work processing program.    You can
use these other programs to make customized reports, or import the TimeSlice exported 
data in a database or financial program for further processing.
Export Preferences
The Export Preferences Dialog box is displayed when you select the Export command.    
Select the export preferences in this dialog box.    Then select the OK button to display the 
standard Export As dialog box.    The Export As dialog box is similar to the Save As dialog 
box.    Specify a file name in the dialog box and click on the OK button to save the active 
documents information in this file.    The default file extension for exported data is '.txt'.    
See Export Preference Dialog Box for more information on setting the export preferences.
Sorting the Time Table rows for Exporting
The Time Table rows are exported in the order that they appear in the Time Table.    If you 
want the Time information to appear in a specific order in a report, first sort the records 
before selecting the Export command.    See Sort Dialog box for more information about 
sorting time table rows.
NOTE:    The Cut and Copy features will place the highlighted time entry records as tab 
delimited text in the Clipboard.    The time table records tab delimited data is the same 
format that is saved to a file with the Export feature.    You can then paste this tab delimited
text into a database or reporting program to format output for reports.



Time an Activity
There are many commands, buttons and menus to help you control the timer.    You can use
the buttons on the Document Window Toolbar, the menus on the Document System Menu, 
the menus under the Time Menu, the function keys F4, and F5, and the menus on the 
Application System Menu.
START Timing
You time an activity by selecting the Start Button on a document or the Start menu on the 
documents control menu or the Start menu on the application system menu or the Start 
menu which is under the Time Menu or by pressing the F4 key.    The ‘Start’ button will show
the time of ‘3:00’ to show that start is valid rather than restart.    The status light will turn 
green when the timer is started.    The start button will be indented to show that the timer 
has been started.
PAUSE Timing
You can pause the timing of an activity by selecting the Pause Button on the document or 
the Pause Menu on the documents control menu or the Pause menu on the application 
system menu or the Pause menu which is under the Time Menu or by pressing the F5 key. 
The status light will turn yellow when the timer is paused.    The pause/resume button will 
show depressed when the timer is paused.
RESUME Timing
You can resume the timing of an activity by selecting the Resume Button on the document 
or the Resume Menu on the documents control menu or the Resume menu on the 
application system menu or the Resume menu which is under the Time Menu or by 
pressing the F5 key.    The status light will turn green when the timer resumes.    The 
pause/resume button will pop out when the timer is resumed.
STOP Timing
You can stop the timing of an activity on a document by selecting the Stop Button on a 
document or the Stop menu on the documents control menu or the Stop menu on the 
application system menu or the Stop menu which is under the Time Menu or by pressing 
the F4 key.    The status light will turn red when the timer is stopped.    The start button will 
show indented when the timer is running.    Therefore when you stop the timer, the 
Start/Stop/Restart button will pop back out.
RESTART Timing
You restart the timer on an existing row by having only the one row selected and then by 
selecting the Restart Button on a document or the Restart menu on the documents control 
menu or the Restart menu on the application system menu or the Restart menu which is 
under the Time Menu or by pressing the F4 key.    The ‘Restart’ button will show the time of 
‘3:10’ to show that a restart is valid rather than start.    The status light will turn green when
the timer is started.    The start/stop/reset button will be indented to show that the timer 
has been started.

The Start/Stop/Restart document and application system control menu text toggles 
between the label of Start, Stop and Restart.    The Pause/Resume document and 
application system control menu text toggles between the label of Pause and Resume.    
The Start / Stop / Restart, and Pause / Resume buttons are located on the Document 
Window Toolbar.
NOTE:    You can have more than one timer running by having more than one document 
open with the timer running on all of the documents.    You can later copy and paste the 
records into one TimeSlice document.



Compact Screen Usage
Two menu commands, two buttons on the toolbars and some preferences are available to 
resize the TimeSlice windows.    These commands are available to have the TimeSlice 
program rearrange its windows quickly to take up the least amount of space on your 
screen.
There are two ways to minimize the size of the TimeSlice windows.    One way is to minimize
all child Document windows at once.    The other way is to shrink the size of child Document
windows individually.
Shrink Child Document Windows Individually

To Shrink or Restore the size of the child windows individually, click on the Compact/Restore
Button located on the Document Window Toolbar.    The two menus Compact and Restore. 
are located under the Window Menu.    These menus will compact or restore the active 
TimeSlice document window.    With the TimeSlice windows compacted, you can start, 
restart, stop, pause and resume timing of your work and restore the size of the child 
window using the buttons on the Document Window Toolbar.    The active time table can be 
edited while the Document Window is compacted by clicking on the Edit Time Button on the
Document Window Toolbar.

Minimized TimeSlice in Taskbar (Windows 95 style)

The TimeSlice application push button in the Windows 95 style taskbar will display the 
active document name and the elapsed time if the timer is running.    If the text in the 
button is to long, the full text will be displayed in a tooltip box when the mouse cursor 
pauses over the TimeSlice toolbar push button.



The TimeSlice document timers can be controlled using the application system menu while 
the application is minimized in the Windows 95 style taskbar.    See Control the Timer while 
TimeSlice is minimized for more information.

Minimized TimeSlice in Taskbar (Windows 3.1 style)

The TimeSlice application icon in the Windows 3.1 style screen layout will display the active
document name and the elapsed time if the timer is running.    The TimeSlice document 
timers can be controlled using the application system menu while the appliction is 
minimized. See Control the Timer while TimeSlice is minimized for more information.

Minimize All Child Document Windows

With the TimeSlice windows compacted, you can start, stop, pause and resume timing of 
your work using the system menu of each iconized document window.    You popup the 
system menu for an icon by clicking on the document icon once.
Compact and Restore Menus
The two menus Compact and Restore. are located under the Window Menu.    

Compact Windows Menu    This command will minimize the TimeSlice document 
windows, arrange them in the upper left portion of the TimeSlice application window, and
resize the TimeSlice application window to contain one row of document icons.
Restore Windows Menu    This command will restore the TimeSlice application window 
to the size and location when the Compact Windows command was executed.

Compact / Restore Application Toolbar Icon
This Compact / Restore Icon is located in the TimeSlice application Toolbar.    The Child 
Windows can be compacted or restored to original locations by clicking on this icon.
Compacting Preferences
You can set preferences for the compacting of the TimeSlice windows in the General 
Preferences dialog box.    The General Preferences dialog box is displayed by selecting the 
General Preferences Menu from under the Time Menu.    The General Preferences dialog box
can also be displayed by selecting the General Preferences Button from the TimeSlice 
Document Window Toolbar.



The two settings you can control for the compacting of the TimeSlice windows are whether 
the status bar or toolbar will automatically be hidden when the Compact Menu is selected.   
These two settings can be changed in the General Preferences dialog box.



Display Time Feature
The Elapsed Time can be displayed in various formats and increments of time.    The 
Elapsed Time is displayed in the Elapsed Time area by the top of the document window, the
elapsed time column in the Time Table and the Total Elapsed time by the top of the 
document window.    
The Elapsed Time Display preferences can be selected in the Set Document Preferences 
Dialog Box.    The time display preferences can be changed by selecting the Document 
Preferences... menu which is under the Time Menu.    The time display preferences can also 
be changed by selecting the Document Preferences Button from the TimeSlice Document 
Window Toolbar.    See Set Document Preferences Dialog Box for more information on 
setting the time display preferences.

Time Display Increments
The exact number of seconds elapsed is saved for a time table row.    The manner in which 
the time is rounded up and displayed on the screen or in reports is affected by the 
selections described here.    The Elapsed time can be displayed in increments of 1 second, 1
minute, 6 minutes, 15 minutes and 100th of an hour.    An example of how the time: one 
hour, 12 minutes and 34 seconds will be displayed in each.

1 second    The elapsed time is displayed down to the second.    This is the only selection
where the seconds are displayed.    The example time is displayed as:    01:12:34
1 minute    The elapsed time is displayed only in hours and minutes.    Any seconds will 
round up to the next minute.    The example time is displayed as:    01:13
6 minutes    The elapsed time is displayed in hours and minutes where the minutes are 
multiples of 6.    The minutes are rounded up to the next multiple of 6.    The example 
time is displayed as:    01:18 in the default format of hours : minutes and the time is 
displayed as:    01.30 in the decimal format.
15 minutes    The elapsed time is displayed in hours and minutes where the minutes are
multiples of 15.    The minutes are rounded up to the next multiple of 15.    The example 
time is displayed as:    01:15 in the default format of hours : minutes and the time is 
displayed as:    01.25 in the decimal format.
100th of an hour    In this time increment display, you select the number of 100th of an 
hour increments to display the elapsed time in.    The number entered in the text box can 
range from 5 - 100.    This number is only used when the 100th of an hour is selected.    
For instance, enter the number 50 to have the time displayed in increments of 30 
minutes (i.e.: 50/100 hour or 1/2 hour).    Another instance, enter the number 10 to have 
the time displayed in increments of 6 minutes (i.e.: 10/100 hour or 1/10 hour).    Another 
instance, enter the number 5 to have the time displayed in increments of 3 minutes (i.e.:
5/100 hour or 1/20 hour).    If the number 50 is entered in the text box, the example time 
is displayed as:    01:30 in the default format of hours : minutes and the time is displayed 
as:    01.50 in the decimal format.

Time Format



Default Format    The default format to display the time in is:
        hour : minute    or    hour : minute : second
Decimal Format    Time can also be displayed decimally in hours and hundredths of an 
hour.    For instance, using time display of 6 minute increments, one hour and 12 minutes 
will be displayed regularly as:    01:12 and in decimal notation the time would be 
displayed as:    01.20
Decimal format is not available for time display increments of 1 second and 1 minute.



Edit Time Table Row
You can edit the information in any of the rows in the Time Table two ways.    You can edit 
each of the items in the Time Table right in the cell.    You can edit a row of Time Entry 
information in the Edit Time Entry dialog box.    You can edit any Time Entry Row.    Editing 
the Start Date, Start Time, Elapsed Time, Paused Time, Hourly Rate, Project, Category, 
Client, Expense, Mark Column and Notes of an Active Time Record is valid.    Editing the 
Stop Date and Stop Time for an Active Time Record is not valid since the timer will change 
the Stop Date and Time until the timer is stopped for that record.
Edit Time Information in the Cell
The Time Table Row    Information can be edited on the main Document Window right in the 
cell in the table.    The Date and Time values will show the format set in the Date and Time 
Settings in your Windows Control Panel.
Select a Cell to Edit:    To edit a cell in the Table, click on the cell to select the cell you 
want to edit.
Begin Edit Mode:    Then put the cell into edit mode.    The cell can be put into edit mode 4
ways:    press the "F2" key, select the Edit Time Table Cell menu, select the Edit Time Table 
Cell Button or just start typing and the contents of the cell will be overwritten.
Edit the Cell:

Start or Stop Date Cell:    The "Start Date" and "Stop Date" cells expect input to be in a
Date format as selected in the Regional Settings of your computer.
Start or Stop Time Cell:    The "Stop Time" and "Stop Time" expect input to be in a 
Time format as selected in the Regional Settings of your computer.    To make inputting 
time easier, you can type in a period instead of a colon and TimeSlice will convert to a 
colon for you.
Elapsed Time Cell: The "Elapsed Time" expects input to be in a 24 hour Time Format.    
The Elapsed Time format is hours : minutes or hours : minutes : seconds.    To make 
inputting time easier, you can type in a period instead of a colon and TimeSlice will 
convert to a colon for you.
Paused Time Cell:    The "Paused Time" expects input to be in a 24 hour Time Format.    
The Paused Time format is hours : minutes or hours : minutes : seconds.    To make 
inputting time easier, you can type in a period instead of a colon and TimeSlice will 
convert to a colon for you.
Hourly Rate Cell:    Enter the amount of the hourly rate.    The currency symbol does not
have to be typed in and will be placed appropriately by TimeSlice.    If you enter an hourly
rate here, this rate overrides the selection in the Project/Category/Client column that is 
set to designate the hourly rate for the row.
Charge Cell:    NOT editable.
Project, Category, Client Cell:    Click on the ‘arrow button’ to drop down the list box.    
Select one of the names in the list box.    A new name for the Project, Category or Client 
column may be added by typing in the drop down list box and hitting the enter button.    
The new name is added to that column with an hourly rate of 0.    Use the Edit Project, 
Category, Client Dialog Box to edit the names in these list boxes.
Expense Cell:    Enter the amount of the expense.    The currency symbol does not have 
to be typed in and will be placed appropriately by TimeSlice. 
Mark Cell:    Click the mark cell to check and uncheck the cell.
Notes Cell:    The "Notes" cell will expand to show 3 lines of text while in edit mode and 
revert back to show the first line when not in edit mode.    The text area will automatically
scroll vertically.    The Notes text is limited to 255 characters per cell.    You can insert line 
feeds into the notes area by entering a "CTRL-ENTER" key combination.    You can move 
up and down in the lines of Notes during edit by using the "UP" and "DOWN" arrow keys.
NOTE:    See the "Auto Time Adjust" section of the General Preferences Dialog Box on 



more information on how the times are adjusted when editing time in the cell of the main
Time Table.

End Edit Mode:    To end the edit of a cell, press the "Enter", "Return", "Tab", or "Shift-Tab" 
key, or click on a different cell.    If there is any error in the changes made to the value of 
the cell, the previous value will be displayed in the cell.
Edit Time Information in the Edit Time Entry Dialog Box
A Time Table row can be edited in the Edit Time Entry dialog box.    In the Edit Time Entry 
dialog box, you can edit a couple fields of the record before the changes are made back to 
the row in the Time Table.    See Edit Time Entry dialog box for more information on editing 
the time table rows in the edit time dialog box.



Manually Add Time Information
You can add Time Information manually by selecting the Add Time Entry Menu from under 
the Time Menu.    The 'Insert' key can also be used to insert a time record into the active 
document.    The Time Entry row will be inserted as the last row in the Time Table.    The 
time record that is inserted will have the current date and time as the start date, start time,
stop date, and stop time.    The elapsed and paused time will be zero.    You can then edit 
the time record to contain the applicable time information.    The time information can be 
edited in the cells on the main screen or in the edit time dialog box.    See the Edit Time 
Table Row section for more information on editing the Time Entries.



TimeSlice Startup Preferences
You can set what documents are opened when TimeSlice starts.    The TimeSlice startup 
Preferences are set in the General Preferences Dialog Box.

You have the following TimeSlice startup preferences: 
• no documents opened when TimeSlice starts,
• open a new document when TimeSlice starts
• open the documents that were open the last time you exited TimeSlice.
NOTE:    If TimeSlice was started with a specified document, then just that document will be 
opened in TimeSlice (for instance double clicking on a TimeSlice Document file).
See the Set General Preferences Dialog Box section for more information on setting the 
preferences on opening documents when TimeSlice starts.



International Date, Time, Currency Customization
You must be using the 32 bit version of TimeSlice to take advantage of the currency part of 
this feature.    Both the 16 and 32 bit versions of TimeSlice will display the date and time in 
the International setting selected on your computer.
TimeSlice will display the Date, Time and Currency as set in the Windows Control Panel - 
Regional Settings.    Chances are that you will not have to do anything special to your 
computer for the TimeSlice 32bit version to display the date, time and currency using your 
Regional Settings.    See the Windows online help - Regional Settings for more information.
Changing Regional Settings
Use the Windows Control Panel to select the Regional Setting for your computer.    Select 
the Regional Setting for your locale.    Then allow your computer to reboot to have this 
change in Regional Setting take affect.    After you select a Regional Setting, you can further
customize how you want the date, time and currency to be displayed.    If you need more 
explanation on how to customize a date, time or currency, while in the Regional Settings, 
click the '?' button in the upper right corner of the Regional Settings dialog box and then 
click on the area of the dialog box that you want more information about.
Be careful when changing the date, time and currency settings in the Regional Settings by 
text editing the values.    Any customization will be reflected in all the software running on 
your computer and how the software will display dates, times and currencies.    So, if you 
make a mistake in your text editing of these settings, these mistakes will be reflected 
consistently across your computer system and software which utilizes the Regional 
Settings.



Project, Category, Client Columns
The Project, Category and Client columns were created to provide a quick and consistent 
way to characterize and annotate a time table row.    These columns also provide an easy 
and consistent way to associate an hourly rate with a time table row.    To provide 
consistency for multiple users of TimeSlice, the name lists and hourly rates can be exported
to a file.    Then all users of TimeSlice can import that file into their document.    This 
mechanism provides consistent names to be used when documents are combined into a 
database or spreadsheet.
See Edit Project, Category, Client Dialog Box for more information about editing the lists of 
names and hourly rates for each column.
See Edit Time Table Row Dialog Box and Edit Time Table Row on how to assign a value for 
each column to a time table row.
See Set Hourly Rate and Edit Time Table Row Dialog Box and Edit Time Table Row for more 
discussion about assigning hourly rates to a time table row.



Create a Template
There are two ways to create a TimeSlice document to have the document settings without 
having to go through and set each document preference individually.
Template Method I:    The first way is to use the settings in a document that you like.    
1.    Open the document that has the settings just the way you want them.
2.    Then Save As with a new name.
3.    Then select all of the rows in the time table and delete them.    
4.    Then Save the document again.    
Template Method II:    The second way is to create a read only document that you will 
open for each new document you need.
1.    Start a new TimeSlice document.    
2.    Set all of the properties that a document can have.    
3.    Save the document.    
4.    Make the document read only.    
5.    Open the template document
6.    Save As a new document name and the new document will have all of the settings for 
you already.



Sort the rows in the Time Table
You can set up sort keys and have TimeSlice continually sort the rows in the Time Table.    
You can also set up the sort keys right before printing or exporting and then turn off the 
sorting after done printing or exporting time rows.    If your system is very powerful, sorting 
continually may not be noticeable.    However, if your machine is slower, you may want to 
only set up the sort, use the sorted rows, and then later turn if off.
Any of the columns can be set as a sort key.    A primary sort column (key), a secondary sort
column and a third sort column can be defined.    Also, for each key, the sort can be defined
as ascending or descending.    For each key, the sort can be case sensitive or case 
insensitive.    Use the Sort menu to display the Sort Dialog box.
For more information on exporting, see Export a Document.    
For more information on printing, see Print a Report.
For more information on sorting, see Sort Dialog Box.



Using the Mark Column
Many of the operations in TimeSlice are on the selected or marked time table rows.    The 
mark column, mark menus and the mark special dialog box were created to help select 
rows more easily.    Some of the operations that are performed on selected or marked rows 
are:    Copy, Cut, Delete, Edit, Export, and Print.
The following Mark menus under the Time menu help mark columns and select and 
unselect rows with the mark column checked.
Mark / Unmark Ctrl+M    
Use this command to toggle the state of the Mark cell of the selected Time Table rows.    
The 'Ctrl M’ key sequence can be used to initiate the Mark / Unmark command.
Mark All    
Use this command to check the Mark cell of all Time Table rows.
Unmark All    
Use this command to uncheck the Mark cell of all Time Table rows.
Select Marked    
Use this command to select the Time Table rows that have the Mark cell checked.
Mark Special... F9    
Use this command to display the Mark Special Dialog Box. The TimeSlice Mark Special 
command can also be activated by selecting the Mark Special Button from the TimeSlice 
Document Window Toolbar.    Pressing the 'F9' key will also display the Mark Special dialog 
box.
For more information about marking rows with special characteristics, see Mark Special 
Dialog Box .



Setting the Time Records to Total
Total Elapsed Time, Charge and Expense Display in Document Window

Three Totals boxes are displayed above the Time Table in each TimeSlice Document Window. 
The Totals are of the Elapsed Time, Charge, and Expense.    You can select the totals to be of 
All Records, the Active Record or the Marked Records.    The text above each of these 
values will denote which type of totals are being displayed.
Total Elapsed Time in Application System Menu

The Total Elapsed Time is displayed at the top of the TimeSlice application system menu - 
document pop-up menu.    The total elapsed time will be either of the active record, all 
records, or the marked records.    Which elapsed time is displayed follows which menu is 
selected in the Time Menu.    See Time Menu Commands for more information.
Total Record Menu Commands

You can select the totals to be of All Records, the Active Record or the Marked 
Records.    Select which totals to display by using the ‘Total Records’ menus in the Time 
Menu.

 Total Active Time Record Ctrl+1
 Total Marked Time Records Ctrl+2
 Total All Time Records Ctrl+3



Expense Feature
Enter a currency amount into the Expense cell for a time record.    Enter a monetary value 
for any purpose you want, independent of the time settings.    For example, during a timer 
period you purchased $20 of paper.    You would enter 20 as the expense, and maybe 
describe the purchase in the Notes section.
The expense amount can be typed in the cell in the Time Table, or entered into the Expense
edit box in the Edit Time Row Dialog Box.    For more information see Edit Time Table Row.
The expense column can be included in the export file or the printed report.    The total 
expenses will also be include in an exported totals line or in the printed totals row.    The 
total expense amount will be the total for all records printed or exported.    For more 
information see the section Print a Report and Export Time Records.

 The Total expense amount is also displayed in a ‘Total Expense’ box above the Time Table 
in the TimeSlice Document Window.    The Total Expenses displayed can be of the active 
row, total of all rows or total of all marked rows.    The choice of which total expenses to 
display is controlled by the menus in the Time Menu.    For more information see the section
Set Time Records to Total.



Controlling the Timer while TimeSlice is Minimized.
If you use TimeSlice to keep track of time while you are working on your computer, you will 
want to access TimeSlice, but you will also want TimeSlice out of your way.    You can 
minimize TimeSlice and control the timer while TimeSlice is minimized.    The TimeSlice 
System Menu can be used to control the timers and edit the active time record on the files 
open in TimeSlice.    This allows you to access TimeSlice but keeps TimeSlice out of the way 
while you work on your computer.

One example of using TimeSlice is to
1. Start TimeSlice.

(You can put TimeSlice in your ‘Startup’ folder so that TimeSlice automatically starts 
when you boot your computer.    You can also set in the TimeSlice shortcut to start 
TimeSlice ‘minimized’. See Windows Help for more information about the startup folder 
and shortcuts.)

2. Open the TimeSlice documents you want to use
Set the General Preference - ‘Open the Documents that were open when last exited 
TimeSlice’. So that you will not need to repeat step #2.    See Set General Preferences 
Dialog Box for more information about TimeSlice startup preferences.

3. Minimize the TimeSlice program
4. Start the Timer

Right click on the minimized TimeSlice program icon and command the timer using the 
system menus.

5. Edit the Active Time Record
Select the ‘Edit Active Time Record’ menu to set the specific aspects of this timed work
period.

6. Pause the Timer
(Lunch Time)

7. Resume the Timer
8. Stop the Timer
9. Shutdown your computer

If you have the TimeSlice ‘auto-save’ feature enabled, the changes to the TimeSlice 
document files will be saved without bothering you for an ‘OK’ when TimeSlice exits.    
(See Set General Preferences Dialog Box for more information about TimeSlice auto-
save preferences).

Minimized TimeSlice Program Icon

The minimized TimeSlice program icon will contain the timer status icon (not on 16bit 
version), the total time (all records, marked records or active records, see Set Time 
Records to Total for more information), and the name of the active TimeSlice document.    



You can command which document you want to be active and show up in the minimized 
TimeSlice program icon while TimeSlice is minimized.    See command ‘Set as Active 
Document’ below for more information.

TimeSlice Application System Menu

The TimeSlice application system menu can be activated by clicking the right mouse 
button on the application minimized icon.    The TimeSlice application system menu can 
also be activated by clicking the left mouse button on the TimeSlice program icon which 
is in the upper left corner of the TimeSlice application menu.    The standard system 
menus appear at the top:    Restore, Move, Size, Minimize, Maximize and Close.    
TimeSlice Document File Name Menu:    The file name of all open TimeSlice 
documents appear at the bottom of the application system menu.    To the left of every 
TimeSlice File Name will be a red, yellow or green icon.

 The icon will be red if the timer for that document is stopped.
 The icon will be green if the timer for that document is running.
 The icon will be yellow if the timer for that document is paused.

The pop-up arrow appears to the right of every TimeSlice File Name.    The arrow signifies 
that the TimeSlice document pop-up menu will appear when the TimeSlice File Name menu 
is highlighted.
TimeSlice Document Pop-up Menu

The TimeSlice Document pop-up menu has three sections.    The sections are the 
document timer information, the timer control menus, and two command menus.
Timer Information:    The top section of the pop-up menu contains a time description 
and time information.    The time section is informational only, these are not command 
menus.

Elapsed Time Description:    The time description denotes if the elapsed time value
is of the ‘Total Active Time Record’, ‘Total Marked Time Records’, or ‘Total All Time 
Records’.    You can select which value to display by selecting the menu under the 
Time Menu.    See Setting Time Records to Total for more information about selecting 
the Total Elapsed Time value to display.
Elapsed Time Value:    The time value is the number of hours : minutes and 



optionally seconds of either the elapsed time of the active record, the total elapsed 
time of all records, or the total elapsed time of all marked records.    The time 
displayed here is the same time that is in the upper left corner of the document 
window above the time table.

Timer Control Menus:    The middle section of the pop-up menu contains two timer 
control menus.

Start/Stop/Restart:    The first row will command the document timer to start, stop, 
or restart the timer.    Select this menu to start, stop or restart the timer for this 
document.
Pause/Resume:      The second row will command the document timer to pause or 
resume the timer.    Select this menu to pause or resume the timer for this document. 
The pause command will be grayed out if the timer is not running for this document.

Command Menus:    The bottom section of the pop-up menu contains two command 
menus.

Edit Active Time Record:    Use this command to edit the active time record for this
document.    This command will display the active time record in the Edit Time Record 
Dialog box.    This command will be grayed out if the timer is not running for this 
document.
Set as Active Document:    This command will make this document the active 
document in the TimeSlice Application.    The total elapsed time (active, all or marked)
of the active document is displayed in the minimized icon of the TimeSlice 
application.    Also in the 32bit version of TimeSlice, the minimized TimeSlice will 
display the red, green or yellow icon to denote the state of the timer of the active 
document.



Column Settings
The following is a list of settings you can change in regards to the column in the Time Table 
and the column data displayed, exported and printed.
Change Width of the Columns in the Time Table:    The column width can be changed 
by using the mouse to move the vertical grid lines in the Time Table.    See Using the Time 
Table Splitter Bars, Row Select Buttons, Column Width Sizing for more information.
Hide Columns in the Time Table:    The columns in the Time Table can be hidden if the 
column is not needed to be viewed.    See Set Document Preferences Dialog Box for more 
information.
Specify the Justification of the Data in each Column of the Time Table:    The Data 
displayed in each row for each column can be specified to be justified as Left, Center or 
Right Justified.    See Set Document Preferences Dialog Box for more information.
Specify the Justification of the Header of each Column in the Time Table:    The 
Column Header displayed at the top of each column in the Time Table can be specified to 
be displayed as Left, Center or Right Justified.    See Set Document Preferences Dialog Box 
for more information.
Override the Default Header of each Column in the Time Table, Printed Report 
and Exported File:    You can change the text that is displayed at the top of each column 
in the Time Table, printed at the top of each column in the Printed Report, or written in the 
column header line of the Exported File.    See Set Document Preferences Dialog Box for 
more information.
Select which Columns to include in a Printed Report:    You can select which columns 
of data are included in the Printed Report.    See Print Preference Dialog Box for more 
information.
Select which Columns to include in an Exported tab-delimited File:    You can select 
which columns of data are written to the export file.    See Export Preference Dialog Box for 
more information.



Time Table Splitter Bar, Row Select Buttons, Column Width Sizing.
Time Table Splitter Bars
The Time Table in the TimeSlice Document Window contains horizontal and vertical splitter 
bars.    Initially the splitter bars are located at the bottom and right sides of the Time Table.   
The cursor will turn to a left and right arrow when the cursor is positioned over the Vertical 
Splitter Bar.    The cursor will turn to an up and down arrow when the cursor is positioned 
over the Horizontal Splitter Bar.    When the cursor changes, hold down the left mouse 
button and drag the splitter bar to the location wanted.    The Horizontal splitter bar can be 
dragged to split the Time Table horizontally so that you can view time table rows from 
different ends of the table at the same time.    The vertical splitter bar can be dragged to 
split the Time Table vertically so you can view Time Table columns that are close to each 
other without hiding columns.    See Set Document Preferences Dialog Box for more 
information about hiding columns.
Time Table Row Select Buttons
The Time Table in the TimeSlice Document Window has a button at the beginning of each 
row.    You can select or unselect a row by clicking on the button to the left of the row.    You 
can toggle all rows to be selected or unselected by clicking on the button in the upper left 
corner of the Time Table.
Time Table Column Width Sizing
The columns of the Time Table can be sized to varying widths.    The cursor will turn to a left
and right arrow when the cursor is positioned between the Column Header Text or over the 
vertical grid lines.    When the cursor changes, hold down the left mouse button and drag 
the column to the left or right to make the column wider or narrower.    The columns can be 
hidden by using the column settings in the document preference dialog box. See Set 
Document Preferences Dialog Box for more information about hiding columns.



Document System Menu
This is the documents System Menu.    It contains the usual document system menus, plus a
start/stop/restart menu and pause/resume menu that mirror the start/stop/restart and 
pause/resume buttons on the document.



Program Minimize / Maximize Buttons
The Programs Minimize and Maximize buttons will act on the entire TimeSlice program 
window.    The Minimize button will reduce the TimeSlice to an icon.    The Maximize button 
will make the TimeSlice program window as big as your screen can handle.



Program Title Bar
The TimeSlice Programs Title Bar will display the TimeSlice program name and the name of 
the active document window.



Program System Menu
The TimeSlice Programs System Menu is the standard program system menu with added 
menus to control the timer and active time record of each open TimeSlice document.



Menu Bar
The TimeSlice Program Menu Bar contains the standard File, Edit, View, Window and Help 
Menus.    For more information about the menus click on Menu Commands and the Help 
Table of Contents will be displayed with a list of menu commands to click on.    



Status Bar
The TimeSlice Status Bar contains the standard help messages for Menu selections.



Application Tool Bar
The TimeSlice Program Tool Bar contains shortcut buttons to execute the standard File-New,
File-Open, File-Save, Edit-Cut, Edit-Copy, Edit-Paste, File-Print and Compact/Restore Child-
Windows and Help commands.



Document Tool Bar
The Document Tool Bar contains shortcut buttons to execute the following commands:    

 Compact/Restore Child-Windows,

    Start    

 Stop 

    Restart Timing,

 Pause    

 Resume Timing,

 Edit Time Entry Row(s),

 Print,

 Export,

 Edit General Preferences,

 Edit Document Preferences,

 Display Mark Special Dialog Box,

 Delete Time Entry Row(s),

 Edit Time Table Cell and

 Help.



Document Minimize / Maximize Buttons
The document Minimize and Maximize buttons will control that documents window size.    
The Minimize button will reduce the document window to an icon at the bottom of the 
TimeSlice window.    The Maximize button will make the document window as big as will fit 
inside of the TimeSlice program window.



Document Title Bar
Every TimeSlice document window has a title bar that displays the name of the file that 
holds that documents information.



Notes
This column holds some notes about this time entry.    The notes are entered or changed in 
the cell or in the Edit Time Entry dialog box.



Charge
This column displays the amount of charge calculated for the duration in this time entry.    
The charge is calculated by multiplying the Elapsed Time by the Hourly Rate.



Expense
This column displays the amount of expense entered for this time entry.    The expense is a 
currency value.



Paused Time
This column holds the paused time for the time entry.    The time is expressed in the hours, 
minutes and optionally seconds paused.    The time is displayed in the format selected in 
the Control Panel - Regional Settings.



Elapsed Time
This column holds the elapsed time for the time entry.    The time can be displayed in 
increments of seconds, minutes, 6 minute, 15 minute and 100th of an hour intervals.



Status Light
This bitmap will show a green light  when the timer is active, a yellow light 
 when the timer is paused and a red light 
 when the timer is not active in the document.



Stop Time
This column holds the time that the time entry was stopped.    The time is displayed in the 
format selected in the Control Panel - Regional Settings.



Start Time
This column holds the time that the time entry was started.    The time is displayed in the 
format selected in the Control Panel - Regional Settings.



Stop Date
This column holds the stop date that the time entry was stopped.    The date is displayed in 
the format selected in the Control Panel - Regional Settings.



Start Date
This column holds the start date that the time entry was started.    The date is displayed in 
the format selected in the Control Panel - Regional Settings.



Time Table
This Table contains rows of Time Entry information.    Each row contains the start and stop 
time with the paused and elapsed time, charge, hourly rate, project, category, client, 
expense, mark, and notes.



Total Charge
The Total Charge is shown in the Total Charge box at the top of the document window.    This
total can be the sum of the 'Charge' cells of ALL rows in this document, the MARKED rows, 
or the ACTIVE row.    See Set Time Records to Total for more information on how to choose 
ALL, MARKED or ACTIVE TOTALS.



Total Expense
The Total Expense is shown in the Total Expense box at the top of the document window.    
This total can be the sum of the 'Expense' cells of ALL rows in this document, the MARKED 
rows, or the ACTIVE row.    See Set Time Records to Total for more information on how to 
choose ALL, MARKED or ACTIVE TOTALS.



Pause / Resume Button
The Pause / Resume button will pause or resume the timer for the current active time entry. 
Clicking on the Pause button will pause the timer for the current active time entry.    Clicking
on the Resume button will resume the timer for the current active time entry.



Hourly Rate
The hourly rate displayed in this column is the hourly rate used by this row.    This row will 
use this rate to calculate the Charge.    You can change the hourly rate using the Edit Time 
Dialog box or the Edit Project, Category, Client Dialog Box.



Mark Column
The X in this column designates that the row is ‘Marked’.    You can mark selected rows to 
be able to print or export a subset of rows from the TimeSlice Document.    The Mark Special
Dialog Box can be used to mark rows with specific characteristics.



Project Column
The Project Name is displayed in this column.    This column contains a list box with 
selections to choose from.    You can type directly into this cell to add a new project name 
with an hourly rate of 0.    The Edit Project, Category, Client Dialog box is used to edit the 
names in this list.    The hourly rate associated with this column’s names can be selected to 
be used to calculate the charge for the time records.



Category Column
The Category Name is displayed in this column.    This column contains a list box with 
selections to choose from.    You can type directly into this cell to add a new category name 
with an hourly rate of 0.    The Edit Project, Category, Client Dialog box is used to edit the 
names in this list.    The hourly rate associated with this column’s names can be selected to 
be used to calculate the charge for the time records.



Client Column
The Client Name is displayed in this column.    This column contains a list box with 
selections to choose from.    You can type directly into this cell to add a new client name 
with an hourly rate of 0.    The Edit Project, Category, Client Dialog box is used to edit the 
names in this list.    The hourly rate associated with this column’s names can be selected to 
be used to calculate the charge for the time records.



Total Elapsed Time
The Total Elapsed Time is shown in the Total Time box at the top of the document window.    
This total can be the sum of the ‘Elapsed’ cells of ALL rows in this document, the MARKED 
rows, or the ACTIVE row.    See Set Time Records to Total for more information on how to 
choose ALL, MARKED or ACTIVE TOTALS.



Start / Stop Button
The Start / Stop button will start or stop the timer.    Clicking on the Start button will start 
the timer and show a new time entry row in the Time Table.    Clicking on the Stop button 
will stop the timer on the active time entry row in the Time Table.    The Active Time row is 
shown in bold font.



Elapsed Time
The Elapsed window shows the time of the active time row.    The time can be displayed in 
increments of seconds, minutes, 6 minute, 15 minute and 100th of an hour intervals.



Active Time Row
The Active Time Row is displayed in bold font.    The Active Row is also the row with the 
timer running.



Select All / Select None Button
This button in the upper left corner of the Time Table will toggle to Select All Rows in the 
Time Table and then UnSelect the Rows in the Time Table.



Select Row Button
The buttons in the left side of the Time Table will toggle to select a rows in the Time Table 
and then unselect the row in the Time Table.    Each of these buttons will control the 
selection of the row it is on.



Time Table Horizontal Scroll Bar
The scroll bar at the bottom of the Time Table is used to scroll the columns to the right or 
left.    If the Time Table splitter bar is used, there will be two time table horizontal scroll bars
used to scroll each pane separately.



Time Table Vertical Scroll Bar
The scroll bar at the right of the Time Table is used to scroll the time rows.    If the Time 
Table splitter bar is used, there will be two time table vertical scroll bars used to scroll each 
pane separately.



Time Table Vertical Splitter Bar
The Time Table vertical splitter bar initially is displayed on the right side of the Time Table.   
The vertical splitter bar can be dragged to the left to split the Time Table into two vertical 
panes.



Time Table Horizontal Splitter Bar
The Time Table horizontal splitter bar initially is displayed on the bottom of the Time Table.   
The horizontal splitter bar can be dragged up to split the Time Table into two horizontal 
panes.



TimeSlice Main Window
TimeSlice Main Window is the usual Windows Multi-Document Application.    The Main 
Window has a title bar, menu bar, tool bar, status bar.    The TimeSlice can have multiple 
files open.    Each file will be opened in its own child window which always resides inside of 
the TimeSlice application.    The following bitmap has 'hot spots' on it so that you can click 
on an area of the bitmap to pop up a window of more information about a particular area of
the TimeSlice window.

The prompts for the toolbar buttons appear in the status bar when a button is depressed.    
The prompts for the toolbar buttons can be shown and the toolbar buttons not executed if 
the cursor is moved off the toolbar button before the mouse button is released.    In the 32 
bit version of TimeSlice, the Tool Tips and status bar prompts will be displayed when the 
mouse moves over the Toolbar Buttons.



Set Document Preferences Dialog Box
The Document Preferences Dialog Box is displayed by selecting the Document Preferences 
menu under the Time menu.    The Document Preferences Dialog Box can also be displayed 
by selecting the Document Preferences Button from the TimeSlice Document Window 
Toolbar.    The active documents Time Display feature settings and Column Settings 
Preference can be altered using this dialog box.
Name of the Active Document    The name of the active document is displayed at the 
top of this dialog box.    The changes made in this dialog box will apply only to this 
document.
Time Display Preference

Select the time increment to display the elapsed time of the active document.    The elapsed 
time can be displayed in increments of seconds, minutes, or multiples of 6 minutes, 15 
minutes or hundredths of an hour.    The time increments of 6 and 15 minute intervals, and 
hundredths of an hour can be displayed in Hour : Minute or in decimal notation.    The "use 
decimal notation" is grayed out when 1 minute or 1 second intervals are selected.    The edit 
box next to the "100th of an hour" is grayed out when "100th of an hour" is not selected
The exact number of seconds elapsed is saved for a time table row.    The manner in which 
the time is rounded up and displayed on the screen or in reports is affected by the 
selections described here.    The Elapsed time can be displayed in increments of 1 second, 1
minute, 6 minutes, 15 minutes and 100th of an hour.    An example of how the time: one 
hour, 12 minutes and 34 seconds will be displayed in each.

1 second    The elapsed time is displayed down to the second.    This is the only selection
where the seconds are displayed.    The example time is displayed as:    01:12:34
1 minute    The elapsed time is displayed only in hours and minutes.    Any seconds will 
round up to the next minute.    The example time is displayed as:    01:13
6 minutes    The elapsed time is displayed in hours and minutes where the minutes are 
multiples of 6.    The minutes are rounded up to the next multiple of 6.    The example 
time is displayed as:    01:18 in the default format of hours : minutes and the time is 
displayed as:    01.30 in the decimal format.
15 minutes    The elapsed time is displayed in hours and minutes where the minutes are
multiples of 15.    The minutes are rounded up to the next multiple of 15.    The example 
time is displayed as:    01:15 in the default format of hours : minutes and the time is 
displayed as:    01.25 in the decimal format.
100th of an hour    In this time increment display, you select the number of 100th of an 
hour increments to display the elapsed time in.    The number entered in the text box can 
range from 5 - 100.    This number is only used when the 100th of an hour is selected.    
For instance, enter the number 50 to have the time displayed in increments of 30 
minutes (i.e.: 50/100 hour or 1/2 hour).    Another instance, enter the number 10 to have 
the time displayed in increments of 6 minutes (i.e.: 10/100 hour or 1/10 hour).    Another 
instance, enter the number 5 to have the time displayed in increments of 3 minutes (i.e.:
5/100 hour or 1/20 hour).    If the number 50 is entered in the text box, the example time 
is displayed as:    01:30 in the default format of hours : minutes and the time is displayed 
as:    01.50 in the decimal format.
Time Format

Default Format    The default format to display the time in is:
        hour : minute    or    hour : minute : second
Decimal Format    Time can also be displayed decimally in hours and hundredths of 
an hour.    For instance, using time display of 6 minute increments, one hour and 12 
minutes will be displayed regularly as:    01:12 and in decimal notation the time would



be displayed as:    01.20
Decimal format is not available for time display increments of 1 second and 1 minute.

Column Setting Preference

Column Name:    The top of the Column Settings Preference is a drop down list box.    
Select the column in this list box that you would like to change or view.    You can change 
several column settings at one time and then click on the OK button to change all 
column settings that you have changed.
Hide Column:    Check this box if you do not want this column to be displayed in the 
TimeTable in the main TimeSlice Document Window.    Uncheck this box if you want to see
this column in the TimeTable.
Justify Column Data:    Select Left, Center or Right Justification for the Data displayed 
for this column in the TimeTable in the TimeSlice Document Window.
Justify Column Header:    Select Left, Center or Right Justification for the Column 
Header which is displayed at the top of the column for this data in the TimeTable in the 
main TimeSlice Document Window.
Column Header Text:    Enter the text that you want to replace the default Column 
header text with.    This text will appear at the top of the column in the TimeTable in the 
main TimeSlice Document Window.    This text will also replace the default column header
text in the Print Report and Export File features.    Leave this edit box empty to use the 
default column header text.
Set to Default Settings:    Click on this button to restore all of the column settings back
to the default values.
See the Change the Column Settings section for more information on column settings 
and changing the column width.

Select the OK button to save any changes in the preferences.    Select the Cancel button to
disregard any changes in the preferences.



Set General Preferences Dialog Box
The General Preferences Dialog Box is displayed by selecting the General Preferences 
menu under the Time menu.    The General Preferences dialog box can also be displayed by
selecting the General Preferences Button from the TimeSlice Document Window Toolbar.    
The Auto Save feature, TimeSlice Startup, Auto Time Adjust, and compacting settings can 
be altered using this dialog box.
Auto Save Preference:

The auto-save feature is enabled when the Auto-Save check box is checked.    In the Minutes 
box, type how often (in minutes) you want TimeSlice to save your work.    See the Auto-Save 
feature section for more information.

TimeSlice Startup Preference:

You can select one of the following TimeSlice startup preferences: 
 no documents opened when TimeSlice starts,
 open a new document when TimeSlice starts
 open the documents that were open the last time you exited TimeSlice.
See the TimeSlice Startup Preferences feature for more information.
Auto Time Adjust Preference:

You can select preferences on how TimeSlice will auto adjust the times in the main Time 
Table when you edit the date and times in the cell of the main Time Table.    
The defaults settings will adjust the elapsed time when the start, stop or paused time is 
edited in the cell.    The default for editing the elapsed time is to auto adjust the start 
date/time.    These settings can be restored by selecting the ‘Restore Defaults’ button.

NOTE:    The stop date will never be adjusted on an active timer row.



Compact Windows Preference:

The two settings you can control for the compacting of the TimeSlice windows are whether 
the status bar or toolbar will automatically be hidden when the Compact Menu is selected.

 Status Bar:    The x'd status bar check box means that the status bar will be hidden when
the Compact Menu is selected.

 Toolbar:    The x'd Tool Bar check box means that the Tool Bar will be hidden when the 
Compact Menu is selected.

Select the OK button to save any changes in the preferences.    Select the Cancel button 
to disregard any changes in the preferences.



Edit Time Dialog Box
The Edit Time Table Row dialog box provides the mechanism to edit the information in any 
of the rows in the Time Table.
There are several ways to bring up the Edit Time dialog box with a row of time information 
to edit.    Double click on a time entry row to bring up the Edit Time dialog box with the 
selected row of information in it.    You can edit time table rows by selecting one or more 
rows in the Time Table and then select the Edit Time menu under the Time Menu.    The Edit 
Time command can also be activated by selecting the Edit Time Button from the TimeSlice 
Document Window Toolbar.    When the Document Window is compacted, the active Time 
Table row can be edited by clicking on the Edit Time Button on the Document Window 
Toolbar.

In the Edit Time dialog box, you can edit the Start Date, Start Time, Stop Date, Stop Time, 
Elapsed Time, Pause Time, Hourly Rate, Project, Category, Client, Mark, and Notes 
information.    The only column that cannot be edited is the charge column.
Tips on editing the Start and Stop Date and Start and Stop Time areas in this 
dialog.    The Start and Stop Date and Start and Stop Time areas can be edited by double 
clicking the digit area (i.e. month, day, year, hour, minute, etc.) you want to change and 
then using the up and down arrow keys to increase or decrease the numeric value.    The 
Date and Time separators (i.e.: ':' or '/') cannot be edited.    The Date and Time digits can be
selected and changed.    You can place your text cursor before a digit and just type a 
number to replace the digit after the cursor.    The Date and Time edit areas will not allow 
an invalid digit to be entered.    For instance, if you want to edit the minute digits and place 
your cursor before the tens digit of a minute value and type '"67", the value of "57" will be 
entered because the minutes ten digit max. is '5'.
How to use the Date / Calendar Control:    



Using the drop down Calendar: .The Start Date and Stop Date areas can be edited by 
clicking on the down arrow button.    A calendar will pop up when the arrow button is 
selected.    The current value in the date edit control will be selected in the calendar.    
Select the year, month and then day.    Selecting the day will pop down the calendar and 
display the selected date in the date edit control.
Start Date and Time:    The Start Date and Time specifies the beginning of a time period.  
The Date and Time format follow the settings in the Control Panel.    See the Auto Adjust 
section below to see how other dates and times are affected by changing the start date 
and time.    If Auto Adjust is checked, you should make sure that the correct ‘date or time 
adjust’ radio button is selected before you edit the start date or time.
Stop Date and Time:    The Stop Date and Time specifies the end of a time period.    The 
Date and Time format follow the settings in the Control Panel.    The Stop Date and Time of 
an Active Time Record will be greyed out since the stop date and time are continually 
updated with the current time.    See the Auto Adjust section below to see how other dates 
and times are affected by changing the stop date and time.    If Auto Adjust is checked, you 
should make sure that the correct ‘date or time adjust’ radio button is selected before you 
edit the stop date or time.
Elapsed Time:    The Elapsed Time is the total amount of time between the Start and Stop 
Time, but subtracting out the Paused Time.    The Elapsed Time is displayed as selected in 
the Time Display settings of the document preferences.    See the Auto Adjust section below
to see how other dates and times are affected by changing the elapsed time.    If Auto 
Adjust is checked, you should make sure that the correct ‘date or time adjust’ radio button 
is selected before you edit the elapsed time.
Paused Time:    The Paused Time specifies the total amount of time to exclude from 
between the Start and Stop Date.    This time is originally generated by the total 
accumulated time the Pause button has been selected.    The "Paused Time" expects input 
to be in a 24 hour Time Format of hours and minutes and optionally seconds.    See the Auto
Adjust section below to see how other dates and times are affected by changing the 
paused time.    If Auto Adjust is checked, you should make sure that the correct ‘date or 
time adjust’ radio button is selected before you edit the paused time.
Auto Adjust Date and Time: If the Auto Adjust box is checked, then the other date 
and/or times are adjusted when the ‘input focus’ leaves a date or time edit box.    If the 
Auto Adjust box is not checked, and you made changes to a date or time and want to see 
the changes reflected in the other date and time edit boxes, click on the Recalculate 
button.    If Auto Adjust is checked, you should make sure that the correct ‘date or time 
adjust’ radio button is selected before you edit a date or time.
NOTE:    If you want to make several changes to the dates and times before any 
recalculation takes place, uncheck the Auto Adjust box.    Make the changes to the date and 
times.    Then select the appropriate date or time adjustment radio button and then click on 
the Recalculate button.
Recalculate: If the Auto Adjust box is not checked, and you made changes to a date or 
time and want to see the changes reflected in the other date and time edit boxes, click on 
the Recalculate button.    Before you click on the Recalculate button, you should make sure 
that the correct ‘date or time adjust’ radio button is selected.
Project:    Select one of the Project names from the list box.    Click on the down-arrow 
button to open the list box of Project names.    Scroll the list to see all of the names.    Select
the name you want to assign to this time table row.    Alternatively, you can add a new 
Project name by typing into the drop down edit list box and pressing the enter key.    The 
new project name will be added to the project list with a default hourly rate of 0.    You can 
also click on the ‘Project Button’ to popup the Edit Project, Category, Client Dialog box to 
change the project information.    See Project, Category and Client Columns for more 
information on the Project column.



Category:    Select one of the Category names from the list box.    Click on the down-arrow 
button to open the list box of Category names.    Scroll the list to see all of the names.    
Select the name you want to assign to this time table row. Alternatively, you can add a new
Category name by typing into the drop down edit list box and pressing the enter key.    The 
new category name will be added to the category list with a default hourly rate of 0.    You 
can also click on the ‘Category Button’ to popup the Edit Project, Category, Client Dialog 
box to change the category information.    See Project, Category and Client Columns for 
more information on the Category column.
Client:    Select one of the Client names from the list box.    Click on the down-arrow button 
to open the list box of Client names.    Scroll the list to see all of the names.    Select the 
name you want to assign to this time table row. Alternatively, you can add a new Client 
name by typing into the drop down edit list box and pressing the enter key.    The new client
name will be added to the client list with a default hourly rate of 0.    You can also click on 
the ‘Client Button’ to popup the Edit Project, Category, Client Dialog box to change the 
client information.    See Project, Category and Client Columns for more information on the 
Client column.
Hourly Rate:    Usually a row calculates the charge using the hourly rate associated with 
one of the Project, Category, or Client columns.    If you want to use a special hourly rate for
this one row, click on the ‘Use this Hourly Rate. . .’ box.    Then the edit box above it will 
allow you to enter in the hourly rate to use.    If you want to return to using the hourly rate 
from the Project/Category/Client columns, then un-check the ‘Use this Hourly Rate. . .’ box.  
See Set Hourly Rate for more information about hourly rates.    See the Edit Project, 
Category, Client Dialog Box or Project, Category and Client Columns for more information 
about the Project, Category, or Client columns.
Mark:    Click on the ‘Mark’ box to toggle the check in the ‘Mark’ box.    This information will 
be reflected in the ‘X’ column on the main Time Table row.    See Using the Mark Column for 
more information about using the Mark column.
Expense:    Enter the expense currency amount in the ‘Expense’ edit box.    This 
information will be reflected in the ‘Expense’ column in the Time Table row in the Document
Window.    See Expense Feature for more information about using the Expense column.
Notes:    A textual note can be added to each time period row.    The total number of 
characters allowed in the note is 255.    The accumulated number of characters entered in 
the Note edit box is shown under the Notes.    The Notes edit box will automatically wrap 
the text.    You can enter 'Carriage Returns' in the Notes edit box to force new lines.
Click on the OK button if you want to transfer this changed information back to the Time 
Table.    If more time table rows were highlighted to be edited, the next row is displayed in 
the dialog box.
Click on the Cancel button to disregard any changes made to the time row information in 
this dialog box.    If more time table rows were highlighted to be edited, the next row is 
displayed in the dialog box.
Click on the Cancel All button to disregard any changes made to the time entry 
information in this dialog box.    The Edit Time dialog box is dismissed even if more time 
entry records were highlighted to be edited.



Edit Project, Category, Client Dialog Box
The Edit Project, Category, Client Dialog Box is displayed by selecting the Project menu or 
the Category menu or the Client menu under the Edit menu.    The Project, Category, Client 
names and Hourly Rate settings can be altered using this dialog box.
If you select the Project Menu, the Project radio button will be selected and the Project 
names and hourly rates will be displayed initially when the Edit Project, Category, Client 
Dialog Box is displayed.    If you select the Category Menu, the Category radio button will be
selected and the Category names and hourly rates will be displayed initially when the Edit 
Project, Category, Client Dialog Box is displayed.    If you select the Client Menu, the Client 
radio button will be selected and the Client names and hourly rates will be displayed 
initially when the Edit Project, Category, Client Dialog Box is displayed.    Select any of the 
Project, Category, or Client radio buttons to edit any one of these three sets of information 
while the dialog box is displayed.
Select the OK button when you are done editing the Project, Category and Client 
information and the information will be saved.    Select the Cancel button if you do NOT 
want to save any changes made to the Project, Category and Client information.
See the Project, Category and Client Columns for more information on how to utilize these 
columns.

Project:    Select the Project radio button to display and edit the Project information.    When
the Project radio button is selected, the 8 buttons below the table apply to the Project 
information.
Category:    Select the Category radio button to display and edit the Category information. 
When the Category radio button is selected, the 8 buttons below the table apply to the 
Category information.
Client: Select the Client radio button to display and edit the Client information.    When the 
Client radio button is selected, the 8 buttons below the table apply to the Client 
information.
Project, Category, Client Table:    The table in this dialog box will hold the names and 



hourly rates for the Project, Category or Client Column.    The radio button selected at the 
top of the dialog box will indicate which set of information is displayed in the table.    The 
names in this table will be contained in the list box for selection in the Project, Category, or 
Client Column respectively on the main Time Table.
Add:    Select this button to add a new row to the end of the table.    The default name can 
be changed by immediately typing after pressing the Add button.    To changed the Hourly 
Rate, click on the hourly rate cell and type in the value.
Delete:    Select this button to delete the selected row(s) in the table.
Sort:    Select this button to sort the rows in the displayed table by the Name column.
Edit:    Select this button to put the cell with the input focus into edit mode.    The cell can 
also be put into edit mode with pressing the F2 button.    The cell with the input focus can 
also be edited by starting to type.
Import:    Select this button to import items from a file that were previously exported using 
the export button in this dialog box.    The rows that are imported are added to the end of 
the table currently displayed.
Export:    Select this button to export the items currently displayed in the table.    This 
exported file can then be imported into another TimeSlice Windows document file.    This is 
one way to have all employees using the same Project, Category and Client names.
Show unused:    Press this button to have all of the rows in the table selected that are NOT
used by any time record rows in this file.
Show duplicates:    Press this button to have all of the rows in the table selected that are 
duplicates.
Use Hourly Rates from:    Select the Project, Category or Client that you want each time 
record to derive its hourly rate from.    You can override this setting on a per record basis.    
See the Set Hourly Rates for more information about setting hourly rates for each time 
record row.
Use Rates in Menu:    Check this box to have the hourly rate appended after the Name in 
the list box for each Project, Category, and Client column in the main Time Table.
Always Sort Items:    Check this box to always have the table in this dialog box sorted by 
Name column.    Use the Sort button if you only want to initiate a sort periodically.
Select the OK button to save any changes in the Project, Category, Client information.    
Select the Cancel button to disregard any changes in the Project, Category, Client 
information.



Mark Special Dialog Box
The Mark Special Dialog Box is displayed by selecting the Mark Special menu under the 
Time menu.    The Mark Special dialog box can also be displayed by selecting the Mark 
Special Button from the TimeSlice Document Window Toolbar. The Mark Special dialog box 
can also be displayed by pressing the F9 key.    Use this dialog box to place x’s in the Mark 
column of rows with specific characteristics.
If the ‘Any . . .’ box is selected for a specification, then the value in that column is not used 
to rule out a row from having the Mark column checked.    That is, if all of the ‘Any . . .’ 
boxes are checked and then the OK button is selected, the Mark column on all rows will be 
checked.    Also, when the ‘Any. . .’ box is checked, the associated specification controls will 
be greyed out.    If the ‘Any . . .’ box is not checked, then the associated specification 
controls are enabled for input.
NOTE:    Start Date and Stop Date range specification.    The Begin Start or Stop Date starts 
at 00:00 on the day specified.    The End Start or Stop Date ends at 23:59 on the day 
specified.    So to specify a date range to include one specific day, set the start and end 
date with that day value.

Start Date Range:    Use this specification to mark the rows with a specific start date 
range.    First uncheck the ‘Any Start Date’ box.    Then specify the date for the beginning of 
the start date range.    Then specify the date for the end of the start date range.    See below
for a description on how to edit the date in the controls.
Stop Date Range:    Use this specification to mark the rows with a specific stop date 
range.    First uncheck the ‘Any Stop Date’ box.    Then specify the date for the beginning of 
the stop date range.    Then specify the date for the end of the stop date range.    See below 
for a description on how to edit the date in the controls.
Project:    Use this specification to mark rows with a specific Project name.    First uncheck 
the ‘Any Project’ box.    Then select the Project name from the Project drop down list box.
Category:    Use this specification to mark rows with a specific Category name.    First 
uncheck the ‘Any Category’ box.    Then select the Category name from the Category drop 
down list box.
Client:    Use this specification to mark rows with a specific Client name.    First uncheck the 
‘Any Client’ box.    Then select the Client name from the Client drop down list box.



Unmark others:    Check this box if you want rows that do not meet the specification in 
this dialog box to have the mark column unchecked.    Have this box not checked if you 
want to add the rows that meet the specification in this dialog box to be added to the rows 
that already have the boxes checked in the mark column.
Example:    Lets say you want to have the Mark column checked only for those rows for the
day of ‘6/12/97’ for a specific Client called ‘Smith’.
1.    Uncheck the ‘Any Start Date’
2.    Enter the Begin Start Date of ‘6/12/97’
3.    Enter the End Start Date of ‘6/12/97’
4.    Check the ‘Any Stop Date’ box
5.    Check the ‘Any Project’ box
6.    Check the ‘Any Category’ box
7.    Uncheck the ‘Any Client’ box
8.    Select the ‘Smith’ name from the Client drop down list box.
9.    Check the Unmark others box
10.    Select the OK button.
Select the OK button to have the mark column changed using the information in this dialog
box.    Select the Cancel button to disregard any changes made to any mark column in any 
row in the main Time Table.
How to use the Date / Calendar Control:    
Using the drop down Calendar: .The Begin Start and Stop Date and the End Start and Stop 
Date areas can be edited by clicking on the down arrow button.    A calendar will pop up 
when the arrow button is selected.    The current value in the date edit control will be 
selected in the calendar.    Select the year, month and then day.    Selecting the day will pop 
down the calendar and display the selected date in the date edit control.
Text editing:    The Begin Start and Stop Date and the End Start and Stop Date areas can be 
edited by double clicking the digit area (i.e. month, day, year) you want to change and then
using the up and down arrow keys to increase or decrease the numeric value.    The Date 
separator (i.e.: '/') cannot be edited.    The Date digits can be selected and changed.    You 
can place your text cursor before a digit and just type a number to replace the digit after 
the cursor.    The Date edit areas will not allow an invalid digit to be entered.
See Using the Mark Column for more information on uses for the Mark column.



Print Preference Dialog Box
The Print Preference Dialog Box is displayed by selecting the Print menu or    Print Preview 
menu under the File menu. The 'Ctrl P' key sequence can be used to display the Print 
Preference dialog box.    You can select the Print button from the TimeSlice application 
Toolbar display the Print Preference dialog box or select the Print Button from the TimeSlice 
Document Window Toolbar.

Time Records:
The option to print all Time Table Rows or the subset of rows that has a check in the Mark 
Column can be selected in the Print Preference Dialog box.    
 Print all time records:    Select this radio button to print all of the records in the active 

TimeSlice document.
 Print marked time records:    Select this radio button to print just those rows that have 

a check in the Mark Column.
Print Options:
There are five print options that can be turned on or off.    If there is a check next to the 
option, that option will occur.    To toggle the check on or off, click on the option’s box or 
text.
 Page header and page number:    Check this box to print the Page Header Text at the 

top of each printed page and the Page Number at the bottom of each printed page.    If this 
box is left unchecked, the Page Header Text and Page number will not be printed on each 
page.    The default page header is the file name.    The default page header can be replaced 
by text specified at the bottom of the print preferences dialog box.

 Column names:    Check this box if the column names will be printed above the column 
data at the top of each printed page.    If this box is left unchecked, the column names will 



not be printed on each page above each column data.    The default or the overridden 
column header text if specified will be used.    See Change the Column Settings for more 
information about changing the column header text.

 Print Notes on next line: Check the ‘Print Notes on next line’ if you want the notes to 
be printed on the subsequent lines, the notes will start printing on the line after the other 
fields in the record and will continue on subsequent lines until all of the notes are printed for 
that time entry.    Uncheck the ‘Print Notes on next line’ if you want the notes to be printed 
on the same line as the other fields, only the portion of the notes that fill to the end of the 
line will be printed.

 Blank line between records:    Check this box if a blank line should be written after 
each row of time data.    Uncheck this box to have each row of time data printed without a 
blank line printed between.

 Totals:    Check this box if the row of totals should be written at the end of the printed 
report.    The totals include elapsed time, charge, and expenses.    If the column that is 
totaled is not selected to be printed, the total for that column also will not be printed
Font Selection:
The Font Name, Style and Point Size can be specified to be used when printing the time 
report.    The currently selected font name, style and point size is displayed.    Click on the 
Change Font button to specify different font characteristics to use when printing the report.

Change Font:    Click on this button to display the Font Selection Dialog box.    In the 
Font Selection Dialog Box, select the Font Name, Style and Point Size and then click on 
the OK button.

Print Columns:
A list of all columns available for printing is shown.    A check next to the column name 
means that the column data will be printed for each record printed.    To toggle the check on
or off, click on the columns box or text.    The default column name or the name you have 
entered to override the default column name will appear in the print column list of the print
preferences dialog.
Page Header:
The File Name is the default header text for the printed report.    Custom text can be 
specified to be used for the Header of the printed report.    This header will not print out if 
the header is not selected to be printed.
 File Name (default):    Select this radio button to use the file name for the header text 

for the printed report.
 Custom Header:    Select this radio button to specify custom text to be printed as the 

page header.    Then enter the text to be used for the Page Header in the edit box 
Select the OK button to save any changes in the preferences.    Select the Cancel button to
disregard any changes in the preferences.
For more information on printing reports in TimeSlice, see the Print a Report section.



Export Preference Dialog Box
The Export command is located under the File Menu.    The 'Ctrl E' key sequence can be 
used to Export data from the active document.    The Export button is located in the 
Document Window Toolbar.    Use this Export menu or button to write all or some time table 
rows of the active document to a tab delimited file.    This tab delimited file can then be 
imported into almost every database, spreadsheet, and word processing program.    You can
use these other programs to make customized reports, or import the TimeSlice exported 
data in a database or financial program for further processing.    The export preferences are 
saved with each document.

Export File:
The option to export the time records to a new file or append the time records to an 
existing file can be selected in the Export Preference Dialog box.    You will specify the name
of the file to export to after the OK button is selected.
 Create a new file:    Select this radio button to export the records to a new file or 

overwrite an existing file.    A new file will be created for you if the file does not already exist. 
If the file already exists, the contents of the file will be deleted before these new records are 
written to the file.

 Append to an existing file:    Select this radio button to export the records to the end of
a file that already exists.    If the file does not exist, a new file is created for you and the 
records are written to this new file.
Export Options:
There are three export options that can be turned on or off.    If there is a check next to the 
option, that option will occur.    To toggle the check on or off, click on the option’s box or 
text.
 Export Column Header Row:    Check this box if the tab delimited column names will be 

the first record written to the export file.    If you are appending to an existing file, generally 
the export column header row option should be turned off - left unchecked.    The column 
names exported will be the default column names, or if the names were changed in the 
column settings preferences of the Document Preferences Dialog Box, the column names 
you entered will be written to the export file.

 Remove carriage returns from Notes:    Check this box if the carriage returns should 



be replaced with spaces in the Notes text before the Notes text is written to the export file.    
The Notes text will not be changed in the TimeSlice file.    If you will be importing the 
TimeSlice export file into a database or spreadsheet or into a word processing table, the 
‘remove carriage returns from Notes’ option generally should be turned on - with a check.

 Export Totals Row:    Check this box if the row of totals should be written to the export 
file.    The totals include elapsed time, charge, and expenses.    If the column that is totaled is
not selected to be exported, the total for that column also will not be exported.    If you will 
be importing the TimeSlice export file into a database, the ‘export totals row’ option 
generally should be turned off - left unchecked.
Time Records:
The option to export all Time Table Rows or the subset of rows that has a check in the Mark 
Column can be selected in the Export Preference Dialog box.    
 Export all time records:    Select this radio button to export all of the records in the 

active TimeSlice document.
 Export marked time records:    Select this radio button to export just those rows that 

have a check in the Mark Column.
Export Columns:
A list of all columns available for exporting is shown.    A check next to the column name 
means that the column will be exported for each record exported to the file.    To toggle the 
check on or off, click on the columns box or text.    The default column name or the name 
you have entered to override the default column name will appear in the export column list 
of the export preferences dialog.
For more information on exporting time records from TimeSlice, see the Export Time Rows 
section.



Sort Dialog Box
The Sort Dialog Box is displayed by selecting the Sort menu under the Time menu.    The 
Sort dialog box can also be displayed by pressing the ‘Ctrl’ key and the ‘B’ key at the same 
time.    The sorting order of records in the Time Table can be altered using this dialog box.    
Up to 3 different sort columns can be specified for sorting.    The First Sort Column must be 
defined before the Second Sort Column can be defined.    The Second Sort Column has to be
defined before the Third Sort Column can be defined.
Turn off Sorting:    Un-Check the ‘Use First Sort Column’ box and click the OK button.

Use XXX Sort Column:    Check the Use First Sort Column box to enable sorting of the 
rows in the main Time Table.    Check each of the Second or Third ‘Use XXX Sort Column’ 
boxes to enable sorting using more than one column.
Column Name List Box:    Select the column name in the list box to define which column 
to sort on.
Ascending:    Select the ascending radio button to specify to sort the values in the selected
column in ascending order.
Descending:    Select the descending radio button to specify to sort the values in the 
selected column in ascending order.
Case Insensitive:    Check the Case Insensitive box if you want the sorting to consider the 
upper case letters to be the same as lower case letters.    If this box is not checked, the 
upper case letters and lower case letters will be identified as different and not grouped 
together.
Select the OK button to save any changes in the Sort Preferences.    Select the Cancel 
button to disregard any changes in the Sort Preferences.
Example:
Lets say that you want to sort your time records by Client, and for each client you want to 
sort the records by Start Date, and then for the records with the same start date, sort by 
start time.    
1.    Check the ‘Use First Sort Column’ box.
2.    Select the ‘Client’ column in the ‘First Sort Column’ sort key information box.
3.    Select the ‘Ascending’ radio button.
4.    Check the ‘Case Insensitive’ box.
5.    Check the ‘Use Second Sort Column’ box.
6.    Select the ‘’Start Date’ column in the ‘Second Sort Column’ sort key information box.
7.    Select the ‘Ascending’ radio button.
8.    The ‘Case Insensitive’ box can be checked or unchecked.
9.    Check the ‘Use Third Sort Column’ box.



10.    Select the ‘Start Time’ column in the ‘Third Sort Column’ sort key information box.
11.    Select the ‘Ascending’ radio button.
12.    The ‘Case Insensitive’ box can be checked or unchecked.
13.    Click on the OK button.
Now the rows in the Time Table on the document windows will have the rows sorted as 
wanted.








































































































